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Getting Set Up
This chapter provides information for getting
started with Looking Glass. This chapter
contains the following sections:

• System requirements

• Installing Looking Glass

• Starting the application for the first time

• Project workflow

•  Troubleshooting and support

•   How to proceed

•   Optimizing performance

Looking Glass streamlines the editing process by providing the traditional tools of postproduction,
the creative control of digital editing, and a simple user interface. More than a method of saving
time and money, non-linear editing introduces a whole new style of craftsmanship into the

postproduction arena. It allows for greater experimentation in the composition of full-motion visual media.
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System requirements
Your computer must meet these requirements to run
Looking Glass:

• Mac OS 9.1, or 10.1 or greater

• QuickTime 4 or greater (Pro version not needed)

• At least 32 MB RAM, 75 or greater
recommended

• Firewire port for DV capture

Installing Looking
Glass

To install Looking Glass

Looking Glass can be distributed either
electronically or via CD. You will need to open the
folder containing the Looking Glass installer to
begin.

• If you received a CD, insert the CD and
locate the folder named “Looking Glass.”

• If you downloaded the application, you will
need to decompress the enclosing folder,
which should be named “Looking Glass.”

Once you have located the folder “Looking Glass,”
open the folder and double-click the file “Looking
Glass Install.” Next, follow the prompts to install
the Looking Glass application. Make sure you read
the Looking Glass README before you begin
using the application.

To install QuickTime

To use Looking Glass you will need QuickTime 4 or
greater. QuickTime comes pre-installed on
Macintosh computer.

If you need to re-install or upgrade your version of
QuickTime then you can go to
http://www.apple.com/quicktime/download. You do
not need the Pro version of QuickTime to use
Looking Glass.
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Allocating memory to Looking Glass

Before you launch Looking Glass, set up the RAM
memory allocation. How much memory you allocate
will depend on how many clips you will be working
with and the size and quality of those clips. If you
will be working with DV clips, then we recommend
you allocate at least 75 MB of RAM. You can only
manually allocate memory in OS 9, as OS X handles
memory allocation automatically. You can check the
amount of memory you have available to Looking
Glass by closing all applications, then choosing
About This Computer from the Apple Menu (Figure
1.1). To allocate memory:

• Click the Looking Glass icon to select it.

• Choose File > Get Info > Memory

• In the Looking Glass info window enter a value
in the Preferred Size field (Figure 1.2).

• Enter a value in the Minimum Size field and
then close the window.

Starting the
application for the
first time
To start Looking Glass, simply double-click the icon
labeled “Looking Glass.” Looking Glass is a fully
carbonized application and is tested to work in Mac
OS 9.x or Mac OS 10.1. When prompted for a serial
number, enter the serial number received via e-mail,
or enclosed with your CD. For a demo you can enter
‘Demo’. Note that in demo mode many of the
advanced features, including the ability to export a
finished movie, will be disabled.

• On OS X systems, Looking Glass opens as a
standard Mac OS X application.

• On Mac OS 9.x systems, Looking Glass will
open as a Mac OS 9 type application
automatically.
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Figure 1.1 Check the amount of RAM you have
available to allocate to Looking Glass.

Figure 1.2 Set memory allocation in the
Looking Glass Info window.



Running in Demo mode

Looking Glass has a Demo mode that allows you to
try out the application for thirty days, after which
you will need to register Looking Glass and
purchase a serial number. 

The first time you start Looking Glass, a dialog box
will appear asking you to enter a serial number.
Type ‘Demo’ (without the quotation marks) in this
box (Figure 1.3). Looking Glass will be active for
thirty days, but with some features disabled, such as
Exporting.

Project workflow
The following sections introduce the five stages of a
project, along with the system terms you encounter
in Looking Glass.

Starting a project

Starting a project involves the following steps:

1. Start Looking Glass.

2. Name your sequence in the Sequence window. 

3. Select a size and frame rate for the sequence in
the Sequence window.

4. Input video.

5. Save your project.

Editing a sequence

1. View your clips in advance and mark IN points
and OUT points.

2. Double-click the Sequence icon to open the
Editor and Timeline.

3. Build your sequence in the timeline.

4. Fine-tune your edits and effects.

5. Adjust volume of audio tracks.

6. Save your project.
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Figure 1.3 Enter ‘Demo’ into the serial number
screen to use Looking Glass for 30-day in demo
mode.



Generating Output

1. Make movie or export movie.

2. Export to tape.

Troubleshooting and
support
For the most up to date troubleshooting and support
tips see the README that came with your copy of
Looking Glass.

How to proceed
The following are a few tips for taking full
advantage of Looking Glass documentation and
other resources:

• Review this guide completely before starting
Looking Glass. A good point of comfort is to
browse the Table of Contents. If you are
familiar with all the terms, you are ready for
Looking Glass. 

• Begin performing basic procedures using the
default settings. As your confidence increases,
begin to explore additional procedures and
settings.

• Keep Appendix C: Keyboard Shortcuts
available during editing sessions to speed the
use of keyboard commands.
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Optimizing
performance
Here is a short list of suggestions that might help
speed up performance in OS 9 and OS X.

OS 9

• Turn off virtual memory in the Memory
Control Panel (Figure 1.4).

• Set your disk cache to the default setting.

• Turn off Web Sharing in the Extensions
Manager.

• Turn off File Sharing in the Control Panel.

• Turn off Apple Talk in the Control Panel.

• Try to avoid running other software while
working in Looking Glass, especially
networking software or software that runs
in the background.

• Do not set Looking Glass’ memory
allocation to an amount higher than the
available RAM.

• Sprite tracks can slow down editing some.
The more sprite tracks that are in one
sequence the more overhead Looking Glass
has to process, and editing slows down.

OS X

• Turn off the Classic Environment.

• Memory cannot be allocated in OS X as in
OS 9, the operating system will do it itself.

• Watch out for how many movies you have
in one project, or sequence at a time. The
more movies, the slower the editing will be.
Likewise, if you have just a few movies
that are huge sizes (up to 2 GB a piece)
editing will be extremely slow.
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Figure 1.4 In the memory control panel, turn
off virtual memory, and use the default disk
cache setting.



Welcome To 
Looking Glass
This chapter provides a general overview of
the capabilities of Looking Glass. It introduces
basic concepts along with some tips for the
beginning user in the following sections:

• The workspace

• Sequence settings window

• The Project Window

• The Source Window

• The Editor Window

• The Sequence Window

Looking Glass has a simple an intuitive interface. From the four main windows, down to the extra
features, Looking Glass makes video editing simple and easy. Before moving on to more complex
tasks, it’s necessary to be familiar with the simple concepts of the program. This chapter will be a

walk through and introduction, allowing you to “meet” Looking Glass before using it.

12

Welcome to Looking Glass

Chapter

2



13

Welcome To Looking Glass

The workspace
The workspace is the combination of windows in
Looking Glass that make up the primary working
area. The workspace consists of: the Project
Window, Editor Window, and Sequence Window
(Figure 2.1). 

Figure 2.1 The workspace consists of these
three main windows.



The Project window contains the sequences,
imported media and rendered movies. Any media or
movie item in the Project Window can be previewed
by double-clicking its icon (Figure 2.2).

The Editor window shows a rough preview of the
timeline. It displays all non-hidden tracks at the time
noted by the scrubber (Figure 2.3).

The Sequence window is the center for editing.
Media is placed here and arranged into a movie. All
effects, transitions and keyframing is handled here
(Figure 2.4).
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Figure 2.2 The Project Window
holds all source clips and
sequences.

Figure 2.3 The Editor Window displays the sequence
being edited.

Figure 2.4 The Sequence Window is where the
editing takes place.



Opening the workspace

As described above, the workspace is made up of
three windows: the Project Window, the Sequence
Window, and the Editor Window.

When a new project is started, the only window that
appears is the Project Window. In order to have
access to the other two windows, a sequence must
be opened. If there is not a sequence present in the
Project Window, one can be started (Figure 2.5).

• Make sure a project is open.

• Click on Sequence from the main menu.

• Choose ‘New.’

Once a sequence is present in the Project Window,
double-click it to access the rest of the Looking
Glass workspace.
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Figure 2.5 Chose File > New > Sequence to start a
new sequence.



Sequence Settings
Window 
Double click on the Looking Glass icon to open the
application. The first window that will appear is
called the Sequence Settings window (Figure 2.6).
It allows you to tell Looking Glass the size of the
clips you are going to be working with. It’s also
important to remember to name your sequence here.

If you will be importing media using a USB capture
device choose Internet Broadband. You can change
the frame rate to support your USB device if
needed. If you will be using a DV Camera, or deck
connected via FireWire, and live in North America,
choose (DV) - NTSC. You can change your
sequence settings at any time while in the
application by clicking ‘Sequence’ in the main menu
and choosing ‘Settings.’

The Frame Rate box in Sequence Settings is used to
configure the display in the Timeline. Whatever you
set the frame rate at determines how the Timeline
displays your movie. This will also be the frame rate
used with the Make Movie feature. The original
movie’s frame rate is never changed, just how the
frame rate is displayed. Frame rate can be changed
at any time while working in a Project.

16

Welcome To Looking Glass

Figure 2.6 The Sequence Settings Window lets you
name and set up the sequence.

Name
(DV) - NTSC

(DV) - PAL

Internet Broadband

Internet 56K

720 x 480

720 x 576

320 x 240

160 x 120

Size Frames Per Second
30

25

15
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Project Window
The Project Window (Figure 2.7) contains all the
media and sequences for a particular project. The
top of the Project Window lists the name given to
the saved project. In this case, the project name is
“Project 1.” There is no limit to the number of
media clips or sequences that can be added to any
one project.

The Project Window has an Options Tab that
contains several special features to assist in the
editing of a project, and the managing of the media
in that project.
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Figure 2.7 The Project Window holds the
sequences and source clips.

Looking Glass
movie sequence

Video Clip

Audio Clip

Missing Media

Sprite track

Project Window
Options Menu



Creating a new project

To create a new project (Figure 2.8):

1. Click ‘File’ in the main menu

2. Select ‘New’

3. Choose ‘Project’

Next, you will be asked to set your sequence
settings. After this, you will have a new, fresh
project ready.

Multiple projects cannot be opened at once.

Renaming sequences and clips

It’s possible to rename the media and sequences
already placed in a Looking Glass project (Figure
2.9). 

To change the name of a clip or sequence in the
Project Window, follow these steps:

1. In the Project window, click on the name of the
clip or sequence you want to change. Make sure
you click on the text.

2. A cursor will appear inside a text box around
the current name.

3. Type a new name and then click anywhere in
the Project Window to close the text box.
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Figure 2.8 Choose File > New > Project
from the main menu to start a new project.

Figure 2.9 You can change the name of
sequences and clips in the Project Window.



Saving projects

Saving a project is simple, and you’ll want to do it
often since projects hold all the important
information about the movie you’re working on.

To save a project

• Click ‘File’ in the main menu and choose
‘Save’ (Figure 2.10).

• OR, push -S on your keyboard.

To save as

• Click ‘File’ in the main menu and choose ‘Save
As’ (Figure 2.10) or push Option-    -S on
your keyboard.

Changing sequence settings

The settings for a sequence can be changed at any
time. 

1. Click on the sequence you want to change in
the Project Window.

2. In the Sequence main menu, choose Settings
(Figure 2.11).

3. When the Sequence Settings window opens,
input the settings you now to apply to that
sequence (Figure 2.12).
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Figure 2.10 Choose Save or Save As in
the File main menu to save your project.

Figure 2.11 You can change the settings
for a sequence by choosing Settings from
the Sequence main menu.

Figure 2.12 Make any changes you want to apply to
the sequence and click OK.



The Options Menu

In the upper right hand corner of the Project
Window is the Options Menu (Figure 2.13). The
Options Menu holds features to assist in media
management and editing. Four features are
accessible through the Project Window Options
Menu:Assets, the Info Window, the
Transitions Window.

To view the options simply find the arrow in the
upper right hand corner of the Project Window and
click it. A drop down list will appear. Click on the
desired feature in the drop down list in order to
access it.

Asset Window

The Assets Window (Figure 2.14) is a tool for
organizing, analyzing, and managing. It lists all
of the sequences, media, and files in the current
project. The tabs along the top indicate what
type of information is being examined in that
column. All the tabs are sortable, so clicking on
a tab will sort all the items listed in that
window.

The Asset Window contains several types of
information. They are:
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Figure 2.13 The Project Window Options
Menu is available from the small tab in
upper right hand corner of the window.

• Type
• Name
• Content Duration
• Content Type
• Time Scale
• URL
• Text
• Volume 1
• Volume 2
• X Anchor
• Y Anchor
•  Content Offset
• Height

• Width
• Transparency
• Z- Order
• X-Position
• Y-Position
• Rotation Angle
• Start Time
• Horizontal Scale
• Vertical Scale
• Duration
• Remote URL
• Constrain X,Y

Figure 2.14 Open the Asset Window
from the Project window Options Menu.



The Asset Window has two divider tabs, one in the
lower left corner, and one on the top right (Figure
2.15). 

These tabs allow the Asset Window to be divided
into fourths, letting you see more information at
once.

To split the Asset Window:

• To split the Asset Window vertically grab the
tab in the lower left corner and drag to the right.
Release it where you want.

• To split the Asset Window horizontally grab the
tab in the upper right corner and drag down.
Release it where you want.

Figure 2.16 shows the Asset Window split vertically
and horizontally. 
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Figure 2.15 The Asset Window has two tabs that divide the window
horizontally and vertically.

Figure 2.16 The Asset Window splits into four distinct sections, and each
section allows you to view a different piece of information.



Info Window 

The Information Window (Figure 2.17) supplies a
clip’s name, length, video and audio format, its size,
as well the clip’s In and Out points if it has been
placed in the Timeline as part of a project. 

The Information Window also keeps track of all the
annotations that are added to a sequence.
Annotations are codes that are embedded in a
QuickTime movie that supply the creation date,
author, copyright, etc. Annotations are discussed
more in Chapter 4: Editing A Movie.

• To view the annotations that have been added to
a sequence make sure the sequence icon is
highlighted in the Project Window.

• Next, open the Information Window from the
Options Tab in the Project Window. 

• Click the small triangle in the upper right corner
of the Information Window to roll out the
Annotations section. This menu lists all the
annotations available and displays which fields
have been added.

Transitions Window

The Transitions Window (Figure 2.18) holds the
video transitions that can be applied between clips.
Applying and using transitions is discussed further
in Chapter 5: Creating Transitions.

The Transitions Window allows you to drag the
transition you want to the timeline and add it
between two clips. Transitions can only be applied
to video clips.
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Figure 2.17 The Info Window displays
information about a clip or sequence.

Figure 2.18 The Transitions
Window holds all the transitions
available for use.



Source Window
The Source Window(Figure 2.19) allows for quick
viewing of the video and audio media that is in a
project. The Source Window plays the original
media source clip. You can access the Source
Window by double clicking a clip in the Timeline or
Project Window. 
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Transport Controls

Audio Controls

Options Menu

Figure 2.19 The Source Window

Mark

In Point

Out Point



On-screen controls & display

All the controls listed here, except for the Audio
Controls appear in the Editor and Sequence
Windows as well. The controls operate the same
way in the Editor and Sequence Windows as they do
here.

Transport controls

Figure 2.20 shows the video controls that
appear along the top of the Source Window.

• Go To In will move the Scrubber to the In
Point set in the Source Window.

• Go To Out will move the Scrubber to the
Out Point set in the Source Window.

• Previous Mark moves the Scrubber to
the previous mark set n the Source Window.

• Next Mark moves the Scrubber to next
mark that has been set in the Source
Window.

• Previous Frame moves the scrubber
backward one frame.

• Next Frame moves the Scrubber forward
one frame.

• Play plays the project from the Scrubber’s
current position to the end of the clip.

• Set In Point sets an In Point for the clip
at the Scrubber’s current location.

• Set Out Point sets an Out Point for the
clip at the Scrubber’s current location.

• Clear In/Out Points removes both the
In and the Out points from the Source
Window.
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Previous Mark 

Go To In

Previous Frame

Figure 2.20 The video controls for the Source
Window

Set In Point

Clear In/Out Points

Set Out Point
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Audio controls

Figure 2.21 shows the audio controls that
appear along the top of the Source Window.
These controls adjust the audio for playback in
the Source Window only, and have no effect on
clips for editing.

• The Volume Control slides to the left and
right, and adjusts the decibel level of the
clip’s audio.

• The Bass Control raises or lowers the
bass response of the clip’s audio.

• The Treble Control raises or lowers the
treble response of the clip’s audio.

• The VU Meters display the clip’s
frequency response in real time.

• Balance moves the strength of the audio
signal between the left and right channel.
Keeping it centered produces an even
output from both channels.

Options Menu

The Options Menu (Figure 2.22) in the Source
Window contains two choices, ‘Normal Size’
and ‘Double Size.’ This adjusts the size of the
video clip being played back in the Source
Window only, and has no effect on media for
editing.
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VU Meters

Treble Control

Bass Control

Balance

Volume Control

Figure 2.21 The audio controls for the Source Window

Figure 2.22 Source Window
Options Menu.



Time scrubber

The Scrubber (Figure 2.23) is a tool that
quickly locates a certain point in time within
a video clip, and appears as a thin red line in
the gray area under the Source Window
name. 

To use the Source Window Scrubber, click on
the red line and drag to the desired point.

Using In & Out points

The In and Out points determine the start and end
frames of a clip that is used for editing. The
majority of editing functions are performed by
adjusting these points,  and setting them for each
clip is the first step in editing a project.

You cannot set In and Out points on a graphic or
image file. 

To set In & Out points

1. In the Project Window, double-click the
clip to open up the Source Window.

2. Position the Scrubber where you would like
to place the In point.

3. Click the Set In button or press I and you
will see the In point appear (Figure 2.24).

4. Position the Scrubber where you would like
to place the Out point.

5. Click the Set Out button or press O and you
will see the Out point appear (Figure 2.25).

To change In & Out points

1. Position the Scrubber where you would like
to place the new In point.

2. Click the Set In button or press I and you
will see the new In point appear. The old In
point will be deleted (Figure 2.26).

3. Position the Scrubber where you would like
to place the new Out point.

4. Click the Set Out button or press O and you
will see the new Out point appear. The old
Out point will be deleted (Figure 2.27).
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Figure 2.23 The Scrubber being
moved to the right.

Figure 2.24 Set an In point by clicking the the Set In
button.

Figure 2.25 Set an Out point by clicking the the Set
Out button.

Figure 2.26 Move the scrubber and click Set In to
set a new In point.

Figure 2.27 Move the scrubber and click Set Out to
set a new Out point.



To clear In & Out points

• To clear In & Out points set in the Source
Window simply click on the Clear In/Out
button (Figure 2.28).

Playing a clip

There are a couple options for playing a clip in the
Source Window.

To play a clip

• To play a clip simply click the Play button
(Figure 2.29) or use the L, 5, or ~ keys.
The clip will play from the Scrubber’s
current position.

To play a clip between In and Out
points

• To play a clip between the In and Out points
that have been set, push the 6 key.

To play one frame at a time

• To play a clip one frame at a time, push 
the 3 (to go to the left) and 4 (to go to the
right) keys, or use the left and right arrows
on your keyboard.

To move the Scrubber to an In or Out
point

1. To move the Scrubber to the set In point
push the Q key.

2. To move the Scrubber to the set Out point
push the W key.

Setting movie view size

The Source Window allows you to view a movie in
either normal or double size. To change the movie
view size:

1. Click the Options Menu to show the drop
down list of movie view options (Figure
2.30). 

2. Select the option you want and the movie
will be resized.
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Figure 2.28 Delete In & Out points by clicking the
Clear In/Out button.

Figure 2.29 Click Play to play a clip from the
Scrubber’s location.

Figure 2.30 Source Window
Options Menu.



Working with clips

Clips can be opened into the Source Window for
viewing or In point, Out point adjustment from the
Project and Sequence Windows. You can have
multiple Source Windows open at once.

• To open clips in the Source Window from the
Project window, simply double-click them
(Figure 2.31).

• To open clips in the Source Window from the
Sequence Window simply double-click on that
clip anywhere in the timeline (Figure 2.32). 

Using timecode to navigate 

The Source Window allows you to navigate through
a clip using Timecode. Timecode navigation works
the same in both the Sequence and Source windows. 

To navigate using timecode

1. Open a clip in the Source Window. Figure 2.33
shows the timecode for a clip in the Source
Window.

2. Highlight the timecode (Figure 2.34).

3. Type in the new timecode you would like to
jump to (Figure 2.35). Push Enter.

4. The Scrubber will jump to the timecode
position entered.
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Figure 2.31 Click on any clip in the Project
Window to view it in the Source Window.

Figure 2.32 Click on any clip in the timeline to
view it in the Source Window.

Timecode is a number assigned to each frame. It
reads in hours:minutes:seconds:frames. So, a
timecode of 02:45:34:12 would mean two hours,
forty-five minutes, thirty-four seconds, and twelve
frames.  There are 30 frames in one second of video. 

Timecode can be measured in Drop Frame or Non-
Drop Frame modes. To learn how Looking Glass
handles timecode, read Appendix A: Working With
DV.

What Is Timecode?

Figure 2.33 Timecode display in the
Source Window.

Figure 2.34 Highlight the timecode to
change it.

Figure 2.36 Type in the new timecode
and hit Enter.



Editor Window
The Editor Window (Figure 2.37) provides real-time
playback of the media, effects, and transitions being
edited, applied, and adjusted in the Timeline. The
Editor Window can be accessed by double-clicking
on any sequence in the Project Window.
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Transport Controls

Timecode Display

Options MenuTool Palette

Figure 2.37 The Editor Window.

Zoom Slider Zoom Selector



On-screen controls & display

All the controls listed here, except for the Tool
Palette appear in the Sequence and Source Windows
as well. The controls operate the same way in the
Sequence and Source Windows as they do here.

The Editor Window is tied directly to a sequence. It
is not used for viewing source footage, like the
Source Window. The Editor Window displays the
sequence that is being edited in the Sequence
Window only.

Transport controls

Figure 2.38 shows the video controls that
appear along the top of the Editor Window.

• Go To In will move the Scrubber to the In
Point set in the Editor Window.

• Go To Out will move the Scrubber to the
Out Point set in the Editor Window.

• Previous Mark moves the Scrubber to
the previous mark set n the Editor Window.

• Next Mark moves the Scrubber to next
mark that has been set in the Editor
Window.

• Previous Frame moves the scrubber
backward one frame.

• Next Frame moves the Scrubber forward
one frame.

• Play plays the project from the Scrubber’s
current position to the end of the clip.

• Set In Point sets an In Point for the clip
at the Scrubber’s current location.

• Set Out Point sets an Out Point for the
clip at the Scrubber’s current location.

• Clear In/Out Points removes both the
In and the Out points from the Editor
Window.

Time scrubber

The Scrubber (Figure 2.39) is a tool that
quickly locates a certain point in time within
a video clip, and appears as a thin red line in
the gray area under the Editor Window name. 

To use the Editor Window Scrubber, click on
the red line and drag to the desired point.
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Figure 2.39 The Scrubber being moved to the
right.

Previous Mark 

Go To In

Previous Frame

Set In Point

Clear In/Out Points

Set Out Point

Set/Clear
Mark

Play

Next Frame

Next Mark

Go To Out 

Clear Out Point

Clear In Point

Figure 2.38 The Editor Window transport controls.



Setting movie view size

The Editor Window has two different zoom controls
that allow you to adjust the window’s view.

Using the slide zoom control

• Figure 2.40 shows the slide zoom control.
Click and drag to the left to zoom in, drag to to
the right to zoom out.

Using the zoom selector

• Figure 2.41 shows the zoom selector. The zoom
selector is next to the zoom slide control, in the
bottom left hand corner of the Editor Window.
Simply choose the zoom level from the pop-
down list that you would like.

Using In & Out points

The In and Out points determine the start and end
frames of a clip that is used for editing. The
majority of editing functions are performed by
adjusting these points,  and setting them for each
clip is the first step in editing a project.

You cannot set In and Out points on a graphic or
image file. 

To set In & Out points

1. Position the Scrubber where you would like
to place the In point.

2. Click the Set In button or press I and you
will see the In point appear (Figure 2.42).

3 Position the Scrubber where you would like
to place the Out point.

4. Click the Set Out button or press O and you
will see the Out point appear (Figure 2.43).

31

Welcome To Looking Glass

Figure 2.40 The slide zoom control.

Figure 2.41 The zoom
selector.

Figure 2.42 Set an In point by clicking the
the Set In button

Figure 2.43 Set an Out point by clicking the
the Set Out button



To change In & Out points

1. Position the Scrubber where you would like
to place the new In point.

2. Click the Set In button or press I and you
will see the new In point appear. The old In
point will be deleted (Figure 2.44).

3. Position the Scrubber where you would like
to place the new Out point.

4. Click the Set Out button or press O and you
will see the new Out point appear. The old
Out point will be deleted (Figure 2.45).

To clear In & Out points

• To clear In & Out points set in the Editor
Window simply click on the Clear In/Out
button (Figure 2.46).

Tool Palette

The Tool Palette(Figure 2.47) provides tools that
allow you to manipulate the video image inside the
Editor Window.

• The Selection Tool allows the content of the
Editor Window to be moved and re-sized.

• The Rotate Tool rotates the content of the
Editor Window.

• The Flip Tool flip the content of the Editor
Window horizontally. Holding the Option key
while using this tool flips the content vertically.
Holding Option plus Shift while using this tool
flips the content vertically and horizontally.

• The Zoom Tool zoom in on the content in the
Editor Window. Holding the Option key while
using this tool will zoom out.
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Figure 2.44 Move the scrubber and click
Set In to set a new In point.

Figure 2.45 Move the scrubber and click
Set Out to set a new Out point.

Figure 2.46 Delete In & Out points by
clicking the Clear In/Out button.

Selection Tool

Rotate Tool Flip Tool

Figure 2.47 The Tool Palette in the Editor Window.

Zoom Tool



Options menu

The Editor Window Options Menu (Figure 2.48) is
accessible by clicking on the small arrow-tab in the
upper right hand corner. When clicked, a small drop
down box will appear listing the choices available.
The choices under the Editor Window Options
Menu are Titling and Action Areas, Object Handles,
and View DV Size.

Titling And Action Areas 

Creating video for television presents a unique
problem: not all televisions have the same
viewable area. The Safe Titling Area (STA) is a
standard dimension set up to ensure that all
action and titles inside this area appears on a
TV screen. By turning on the Safe Titling Area
(Figure 2.49), Looking Glass superimposes two
yellow bounding boxes into the Editor Window
as guides. These boxes are not recorded onto
the project. The STA is discussed further in
Chapter 6: Creating Effects &
Compositing.

Object Handles  

Object Handles (Figure 2.50) appear as a thin,
yellow bounding box around media inside the
Editor Window. When using the Selection Tool,
you can grab onto the edges of the object
handles to resize the video or graphics in the
Editor Window.
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Figure 2.48 The Editor Window Options
Menu.

Figure 2.49 Safe Titling area bounding box in the
Editor Window.

Figure 2.50 The Object Handles bounding box in the
Editor Window.



View DV menu 

DV (digital video) aspect ratio is different on a
TV screen than on a computer screen. DV size
is explained in further depth in Appendix A:
Working With DV. The DV View menu,
show in Figure 2.51, provides four options to
how you would like to preview your project.
Actual DV size allows you to view the current
project in the aspect ratio it will be seen in on a
T.V. screen. 

See Chapter 6: Creating Effects &
Compositing for an in depth look on how to
use the View DV feature.
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DV and Display Size

Unadjusted computer DV size Adjusted with View DV feature

Figure 2.52 DV video displayed on a
computer is compressed vertically.

Figure 2.53 DV video as it would appear on a
TV.

Figure 2.51 The View DV menu gives several
options for viewing a clip as it will appear on a T.V.

DV (digital video) aspect ratio is different on a T.V. screen than on a computer screen. DV size is explained further
in Appendix A: Working With DV. The pictures below demonstrate the differences in DV on a computer and
T.V. Notice that the hoop, a perfectly round image, is displayed properly on a television, but not a computer. 



Using timecode to navigate 

The Editor Window allows you to navigate through
a clip using Timecode. 

To navigate using timecode

1. Open a clip in the Source Window. Figure 2.54
shows the timecode for a clip in the Source
Window.

2. Highlight the timecode (Figure 2.55).

3. Type in the new timecode you would like to
jump to (Figure 2.56). Push Enter.

4. The Scrubber will jump to the timecode
position entered. 
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Timecode is a number assigned to each frame. It
reads in hours:minutes:seconds:frames. So, a
timecode of 02:45:34:12 would mean two hours,
forty-five minutes, thirty-four seconds, and twelve
frames.  There are 30 frames in one second of video. 

Timecode can be measured in Drop Frame or Non-
Drop Frame modes. To learn how Looking Glass
handles timecode, read Appendix A: Working With
DV.

What Is Timecode?

Figure 2.54 Timecode display in the
Source Window.

Figure 2.55 Highlight the timecode to
change it.

Figure 2.56 Type in the new timecode
and hit Enter.



Sequence Window
The Sequence Window (Figure 2.57) is where all
editing takes place. It’s in the Timeline that media is
assembled to form a movie.
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Figure 2.57 The Sequence Window
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Transport controls

Figure 2.58 shows the video controls that
appear along the top of the Sequence Window.

• Go To In will move the Scrubber to the In
Point set in the Sequence Window.

• Go To Out will move the Scrubber to the
Out Point set in the Sequence Window.

• Previous Mark moves the Scrubber to
the previous mark set n the Sequence
Window.

• Next Mark moves the Scrubber to next
mark that has been set in the Sequence
Window.

• Previous Frame moves the scrubber
backward one frame.

• Next Frame moves the Scrubber forward
one frame.

• Play plays the project from the Scrubber’s
current position to the end of the clip.

• Set In Point sets an In Point for the clip
at the Scrubber’s current location.

• Set Out Point sets an Out Point for the
clip at the Scrubber’s current location.

• Clear In/Out Points removes both the
In and the Out points from the Sequence
Window.

Time scrubber

The Scrubber (Figure 2.59) is a tool that
quickly locates a certain point in time within
a video clip, and appears as a thin grey line
that runs down the height of the Sequence
Window. 

To use the Sequence Window Scrubber, click
anywhere in the timeline area at the top of the
window and drag back and forth.
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Figure 2.59 The Scrubber in the
Sequence Window is a thin grey line.
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Set In Point

Clear In/Out Points

Set Out Point

Set/Clear
Mark

Play

Next Frame

Next Mark

Go To Out 

Clear Out Point

Clear In Point

Figure 2.58 The Scrubber in the Sequence Window
is a thin grey line.



Timeline zooming and scrolling

The Sequence Window in Looking Glass has a
timeline with a variable time scale. You can view
minutes at a time, or zoom in to view a project
frame by frame.

To adjust the time scale of the timeline

1. The zoom slider (Figure 2.60) in the lower left
hand corner of the Sequence Window is the tool
that adjusts the time scale. 

2. Drag the ribbed button to the left to zoom in on
your project.

3. Drag the ribbed button to the right to zoom out
and expose more of your sequence. 

To scroll a sequence

1. If a sequence has become longer than the
window length, use the scroll bar at the bottom
of the Sequence Window to view the rest of
your project (Figure 2.61).

2. If a sequence has become taller than the
window, use the scroll bar at the right side of
the Sequence Window to scroll vertically, and
view the rest of your project (Figure 2.61).

Add time to beginning

Looking Glass allows you to add blank time to the
beginning of a sequence. This effects all tracks
within a sequence.

1. Make sure the Sequence Window is the active
window.

2. Choose ‘Add Time to Beginning’ from the
Sequence main menu (Figure 2.62).

3. A dialog box will appear asking you to specify
how much time you want to add to the
beginning of the sequence. The default time is 1
second.

4. Type in the time you desire to add and click OK
(Figure 2.63).
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Figure 2.60 The zoom slider in
the Sequence Window changes
the time scale of the timeline.

Figure 2.61 The scroll bars scroll
horizontally and vertically to allow you to
view big projects.

Figure 2.62 Choose ‘Add Time to
Beginning’ From the Sequence main
menu.

Figure 2.63 Type in how much time you want to add,
then click OK.



Track controls

Each track in the Sequence Window has its own set
of controls, as show in Figure 2.64. These controls
allow changes to be made to each track individually.
Several of these buttons have more than one state,
and are illustrated in the pictures below.

• Bar View: The bar view toggles frame picons
on and off for each clip in that track. It has
three states: frames off, first and last frames,
and all frames (Figure 2.65). Frames off is the
default normal view for all clips in the timeline,
and is also the fastest to work with. Turning on
first and last frames displays the first frame and
the last frame of each clip. Turning on all
frames displays every frame of every clip in
that track. Figure 2.66 shows exactly how the
bar view effects the clips in a track.
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Bar View

Solo Edit Mode
Render

ShyLock

Show/Hide

Figure 2.64 Track controls in the Sequence
Window.

Figure 2.65 The bar
view has 3 states.

Figure 2.66 The bar view control turns all frames
off, turns on first and last frames only, or turns on
all frames.



• Edit Mode: The edit mode control toggles
back and forth between overlay mode and insert
mode (Figure 2.67). Overlay mode is the
default mode for a track. While in overlay
mode, media will be replaced and overwritten
with any media you drag on top of it, including
blank space. In insert mode, any media placed
in a track is positioned inside any clip already
there. 

• Render: the render settings button (Figure
2.68) allows you to specify the compression
settings for the audio, graphic, and video of
each track. See Chapter 8: Rendering for
more on this feature.

• Show/Hide: This control (Figure 2.69) turns
a track on and off in the Editor and Sequence
Windows. If a track is hidden it is disabled
when using the Export and Make Movie
commands, and will not be visible or audible in
final output.

• Lock: Lock makes a track unchangeable. When
a track is locked, no adjustments, edits, or
additions can be made to that track. Locked
tracks will still appear in final projects that are
saved out using Export and Make Movie.
Figure 2.70 shows the two states of the lock
button.

• Solo: When solo (Figure 2.71) is turned on for
a track, all the other tracks in the Sequence
Window are automatically muted, making it the
only track that will be processed if the Export
or Make Movie command is used.
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Figure 2.70 Locking a
track makes it
unchangeable.

Figure 2.71 Use Solo
to make only one track
active.

Figure 2.67 The edit
mode control toggles
between overlay (left)
and insert (right).

Figure 2.69 The
show/hide button disables
a track in the Editor and
Sequence Windows.

Figure 2.68 The
Render Settings
Button



• Shy: Using the shy control (Figure 2.72) on a
track hides it from the Sequence Window to
reduce clutter if there are too many tracks to
keep up with at once. Using the shy control
does not eliminate a track, and they will still be
processed if the Export or Make Movie
commands are used.

To use the shy control

1. Click the shy button for each track you
want to hide.

2. Next, select ‘Hide Shy Tracks’ from the
Sequence main menu (Figure 2.73). All the
tracks you specified to be shy will be
hidden from the Sequence Window.

3. To bring back the tracks you have hidden,
click ‘Show Shy Tracks’ from the Sequence
main menu (Figure 2.74).
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Figure 2.73 Select ‘Hide Shy Tracks’
from the Sequence menu to hide
tracks.

Figure 2.74 Select ‘Show Shy Tracks’
from the Sequence menu to reveal
tracks you had hidden.

Figure 2.72 Click the shy
button to hide a track from
the Sequence Window.



Tracks

A sequence in Looking Glass is composed of media
clips which are held in tracks.

Creating a track

There are multiple ways to create a new track in
the Sequence window.

From the File menu

1. Make sure the Sequence Window is active.

2. From the File main menu choose ‘New,’
then choose ‘Track’ (Figure 2.75).

Using the keyboard

1. Make sure the Sequence Window is active.

2. On your keyboard push -K.

By dragging in media

1. Dragging a video or audio clip into the
Editor Window or Sequence Window will
create a new track.Figure 2.76 shows a
clip being placed in the Sequence Window
from the Desktop.

Naming a track

1. To change the name of a track, click on the
default track name (Figure 2.77).

2. Next, a cursor will appear and allow you to
change the name of the track.

3. After you type in the new name, hit Enter and
the name will take effect (Figure 2.78).
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Figure 2.75 One way to create a new track
is by choosing ‘New Track’ from the File
menu. 

Figure 2.76 Dropping a clip into the Sequence
Window from the desktop creates a new track.

Figure 2.77 Click on the default track name
to change its title.

Figure 2.78 After you type in the new name,
hit Enter for it to take effect.



Opening a track

A track can be opened to reveal  the clip effect
controls for each clip in that track.

1. Click the small arrow in the upper left hand
corner of the track by the track name (Figure
2.79).

2. The track will roll open, revealing all of the clip
in that track. Click on the small arrow by any
clip (Figure 2.80) to reveal the clip effect
controls.

Duplicating a track

Duplicate all

1. To duplicate a track and everything in it,
click on the grey area under the track name,
selecting the track.

2. Click the duplicate button (Figure 2.81).
The track will be duplicated and added to
the current sequence. 

Duplicate with one selected clip

1. To duplicate a specific clip in a track that
has multiple pieces of media, first click on
and select the clip to be duplicated.

2. Next, click the duplicate button (Figure
2.81), the track will duplicated and added to
the sequence but only the selected clip will
be inside the new track.

Deleting a track

Using the trashcan

1. To delete a track using the trashcan, click
on the grey area under the track name to
select the track.

2. Next, click the trashcan button at the
bottom left-hand side of the Sequence
Window (Figure 2.82).

3. Or simply click and drag the track you
want to be deleted to the trashcan, and it
will delete automatically.

Using the keyboard

1. To delete a track using the keyboard, click
on the grey area under the track name to
select the track.

2. Next, push the Delete key on the keyboard.
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Figure 2.80 Click on the arrow by any clip to
reveal the controls for that clip.

Figure 2.79 Click on the arrow by the track
name to open a track.

Figure 2.81 The duplicate button in the
bottom left hand side of the Sequence
Window.

Figure 2.82 Click the trashcan icon to
delete a selected track.



Ways to delete a clip

Using the trashcan

1. To delete a clip using the trashcan, click on
it to make sure its selected.

2. Next, click the trashcan button at the
bottom left-hand side of the Sequence
Window (Figure 2.83).

3. Or simply click and drag the clip you want
to be deleted to the trashcan, and it will
delete automatically.

Using the keyboard

1. To delete a clip using the keyboard,click on
it to make sure its selected.

2. Next, push the Delete key on the keyboard.

Clip effects

Each clip in a sequence has editable effects. This
section will show you how to edit these effects. 

Geometrics

Geometrics are turned off by default. You must
turn them on if you desire to use any of these
effects. 

• Anchor: the anchor control defines the center
point for the clip. The center point determines
the axis the clip will rotate on when using the
rotation control.

• Position: The position of a clip inside the
Editor Window is adjustable. A clip can be
dragged to a new position, or the placement
values, in pixels, can be manually adjusted.
Position is keyframeable.

• Size: A clip’s size is given in pixels for width
and height. These pixels values can be manually
adjusted, or you can click on a clips object
handles inside the Editor Window and resize a
clip by dragging.

• Rotation: Rotation allows you to rotate a clip
clockwise or counter-clockwise in the Editor
Window. 

Appearance

• Transparency: The transparency control
determines the opacity of a clip. The default
transparent value is 0, meaning a clip is fully
opaque. Transparency is not keyframeable.
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Figure 2.83 Click the trashcan icon to
delete a selected clip.



Audio

• Wave form: A waveform is a graphical
representation of a clip’s audio signal. This data
is unalterable, but it can aid in making precise
edits.

• Gain: The gain control adjusts a clip’s volume.
The default setting for a clip’s volume is 0.
Gain can be adjusted using positive or negative
numbers, from -64 to +64.

Opening clip effects

1. Open a track as shown in Figure 2.84 by
clicking on the arrow by the track name.

2. Open the clip, like in Figure 2.85, by clicking
on the arrow next to the clip you want to alter.
The clip will open, revealing the three clip
effects panels.

3. Open the clip effect you want to alter by
clicking on the arrow by the clip effect name
(Figure 2.86).
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Figure 2.85 Click on the arrow by any clip to
reveal the controls for that clip.

Figure 2.86 Click on the arrow by an effect
to open up the control panels for each effect.

Figure 2.84 Click on the arrow by the track
name to open a track.



Turning clip effects off and on

When an effect is turned off it is not exported when
using the Make Movie or Export commands. 

Each effect individually

1. Beside each effect name is a check mark. To
turn off that effect, click on the check mark
(Figure 2.87). The check mark will become a
line, indicating the effect is turned off (Figure
2.88).

Turning off all effects for a clip

1. To turn of all the effects for a clip, find the
check mark to the right of the clip name.

2. Click this check mark to have it to turn to a
line, this disables all the effects for that clip,
including the audio (Figure 2.89). No audio will
play when this check mark is turned off.

Working with keyframes in the timeline

Keyframes indicate that an effect parameter is
changing over time. A keyframe is created at a place
where you want to change the value of an effect’s
parameters, like an edit point.

The clip effects that are keyframeable are Size,
Position,  Anchor, and Audio Gain.

Using the keyframe controls

Keyframes have their own controls. They
appear to the right of the clip effect controls
(Figure 2.90). Clicking the box while it is
empty like in Figure 2.90 will set a keyframe at
the Scrubber’s present location with the current
effect values. 

When a keyframe is present the arrows on either
side of the box will become dark. They are used
to jump the timeline Scrubber from one
keyframe to the next. When an X is present in
the box, the Scrubber is resting on a keyframe.
Clicking the X would then delete the keyframe
(Figure 2.91).
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Figure 2.87 Click on the check mark by the
effect name to turn that effect off.

Figure 2.88 When the check mark becomes
a line, the effect is turned off.

Figure 2.89 Click on the check mark by the
clip name to turn off all the effects for that
clip.

Figure 2.90 The keyframe controls appear
as a box with an arrow on either side to the
right of the effect controls. Clicking the box
will set a keyframe with the current values.

Figure 2.91 When an X is inside the box, it
means the Scrubber is resting on a
keyframe. Clicking the X will delete the
keyframe.



Setting keyframes

A keyframe can be set either by adjusting the
values in the clip effects control panels, or by
moving an object in the Editor Window.

Using clip effects control panels

1. Open the effect you want to adjust by
clicking the arrow next to the effect name.

2. Move the scrubber where you would like to
place the first keyframe.

3. Enter the value you want in the effect
control panel.Figure 2.92 shows a new
gain value being typed into the Audio
effects control panel. 

4. Push Enter after you type in the value you
want and a keyframe will be set (Figure
2.93).

Moving objects in the Edit Window

The Size, Anchor and Position effects can be
altered by moving the clip inside the Edit
Window

1. In the timeline, select the clip you want to
alter by clicking on it.

2. If you will be changing the size of the clip,
make sure the Object Handles are turned on
by using the Editor Window Options Menu
(Figure 2.94).

3. Move the Scrubber to the point in the
timeline that you would like to set a
keyframe.

4. To change the size of the clip, grab the
object handles and make adjustments. A
keyframe will be set (Figure 2.95).

5. To change the position or anchor of the
clip, click in the center of the clip and drag
to the desired location. A keyframe will be
set.
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Figure 2.92 Here, a new gain value is being
typed in. 

Figure 2.93 Push Enter after typing in the
value you want, and a keyframe will be set.

Figure 2.94 Turn on Object Handles in
the Editor Window Options Menu.

Figure 2.95 Click on the Object Handles and drag to
change the size of a clip.



Moving keyframes

1. Keyframes appear as diamond icons in the
timeline. Figure 2.96 shows a keyframe being
dragged to the left. Notice it is still visible in its
old location for reference. 

2. Figure 2.97 shows the keyframe in its new
location.

Deleting keyframes

1. Use the arrows in the keyframe controls to
move the Scrubber to the keyframe you want to
delete.

2. When the Scrubber is resting on a keyframe, an
X will appear in the keyframe control box
(Figure 2.98). 

3. When the Scrubber is over the keyframe you
want to delete, click the X and the keyframe
will be removed (Figure 2.99).

To change keyframe parameters

1. Open the clip that contains the keyframe you
want to alter (Figure 2.100).

2. Use the arrows in the keyframe controls to
move the Scrubber to the keyframe you desire
to change.

3. Once at that keyframe you can edit the values
manually, or change the clip in the Editor
Window. They keyframe will automatically
update itself.
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Figure 2.96 Keyframes appear as diamond
icons in the timeline. Here, a keyframe is
being moved to the left.

Figure 2.97 The keyframe is now in its new
position.

Figure 2.98 An X in the keyframe control
box means the Scrubber is resting on a
keyframe. 

Figure 2.99 The keyframe has been
deleted after clicking the X inside the box.

Figure 2.100 Click on the arrow by the track
name to open a track.



Using marks

Marks are reference points that can be used for
numerous things:  to remind you of specific frames
you wanted to line up with, use the mark notes
functions to make small reminders for yourself
among others.

Marks appear as yellow dots in the timeline. They
also appear at the bottom of the Editor Window
along with timecode they were set at, or the name
you gave them (Figure 2.101). Marks will not
appear in the final output of a movie.

Adding marks

A mark can be added to a sequence from the
Sequence or Editor Windows.

1. First, move the Scrubber in Sequence or
Sequence Window to where you would like to
place the mark.

2. Click the Add Mark button to add a mark to the
Scrubber’s current position (Figure 2.102). A
mark will appear in the timeline as a yellow dot
(Figure 2.103).
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Figure 2.102 Click the Add Mark button to add a
mark at the Scrubber’s current position.

Figure 2.103 Marks appear as yellow dots in the
timeline.

Figure 2.101 A mark made in the Sequence or
Editor Windows will appear on that frame of the clip
at the bottom of the Editor Window.



Moving between marks

1. Click the Previous Mark button, located in the
Sequence and Editor Window transport
controls, to move the Scrubber to the previous
mark (Figure 2.104).

2. Click the Next Mark button, located in the
Sequence and Editor Window transport
controls, to move the Scrubber to the previous
mark (Figure 2.105).

Deleting a mark

1. To delete a mark, use the Previous and Next
mark buttons to move the Scrubber to the mark.

2. Hold down the Command key and lick the Add
Mark button to delete the mark.

Deleting all marks

1. Hold down the Shift and Command keys and
click the Add Mark button.

2. All the marks in the sequence will be deleted.

Mark options

1. Hold down the Option key and click the Add
Mark button to bring up the Mark Options
Menu (Figure 2.106).

• Add Mark: The add mark option adds a
mark at the Scrubber’s current location and
allows you to give it a unique name (Figure
2.107). The default name for a mark is the
timecode at which it was set.

• Change Mark Name: Allows you to
choose of all the marks currently in the
sequence and change their name. The
default name for a mark is the timecode at
which it was set.

• Jump To Mark: The bottom of the Mark
Options Menu lists all the marks in the
sequence. Clicking on one of them
automatically jumps the Scrubber to that
mark.
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Figure 2.104 Click the Previous Mark button to go to
the previous mark in the sequence.

Figure 2.105 Click the Next Mark button to go to the
next mark in the sequence.

Figure 2.106 Hold down the Option key and click the
Add Mark button to bring up the Mark Options Menu.

Figure 2.107 Add any name you would like to the
mark about to be created.



Scrolling the sequence with the timeline

Sometimes a movie sequence can be so big that it
“goes off the screen” so to speak of the Sequence
Window. In these cases, you have to scroll over to
view other parts of your project. 

By default, the sequence does not scroll as it plays if
it is bigger than the actual window. To make sure
the sequence will scrolls as it plays:

1. In the Sequence main menu, choose Sequence
Scrolls With Timeline (Figure 2.108).

2. When the command is checked, it is active
(Figure 2.109). 
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Figure 2.108 Choose Sequence Scrolls With
Timeline to have the sequence scroll as it plays.

Figure 2.109 When there is a check mark by the
menu command, then the sequence will scroll as it
plays.



Bringing Media
Into A Project

This chapter will show you all the ways to
bring media into Looking Glass. The following
sections are in this chapter:

• Importing media

• Drag & drop

• Moving media from the Source Window to a sequence

• Find File

• Working with graphics

• Capture

Managing and organizing the media you’ll be working with is a priority. This chapter will guide
you through the many ways to get files into Looking Glass, how to search your computer for
usable media files, and how to capture video from an outside source.
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Importing media
Sometimes dragging and dropping a file into
Looking Glass is not the most efficient way of
working. This is what Import is for. Import does not
change a file in any way, and it accepts the exact
same type of files that dragging and dropping does.

Looking Glass will not import multiple track
movies, and movies that are copyright protected
cannot be used either. 

1. To use the Import feature, select the Project
window. Select ‘Import Media’ from the File
menu (Figure 3.1).

2. From the window that opens, select the file you
want to import into Looking Glass.

3. The file will automatically be added to the
Project Window.

Drag & drop
Looking Glass fully supports the drag and drop
capabilities of the Mac OS. Drag and drop allows
you to simply a drag a file from anywhere on your
computer to one of Looking Glass’ three main
windows and that file will automatically be added to
your project.

To the Project Window

Files can be dropped into the Project Window from
the desktop (Figure 3.2) or anywhere on your
computer. These files are immediately added to the
project.

To the Sequence Window

Files can be dropped directly into the Sequence
Window from the desktop (Figure 3.3) or anywhere
on your computer. This adds them to the current
project, as well as to the current sequence.

To the Editor Window

Files can be dropped directly into the Editor
Window from the desktop (Figure 3.4) or anywhere
on your computer. This adds them to the current
project, to the current sequence, and they are
displayed in the Editor Window.

Figure 3.1 Choose File > Import
Media to use the import command.

Figure 3.2 Here, a file is being dropped into
the Project Window from the desktop.

Figure 3.3 Here, a file is being dropped
into the Sequence Window from the
desktop.

Figure 3.4 Here, a file is being dropped into the
Editor Window from the desktop.



Moving media from
the Source Window to
a sequence
After setting the In and Out points for a clip in the
Source Window as discussed in Chapter 2, it’s
simple to add that media to a sequence.

1. Make sure the Sequence Window is open.

2. Drag the clip from the Source Window to the
Sequence Window and drop it in the time line
(Figure 3.5).

Find File
Looking Glass will search your computer for media
files that can be used in projects. The file types
Looking Glass looks for are Looking Glass project
files, movies, MP3 files, AIFF files, and text files.

1. To open the Find File window select ‘Find File’
from the File main menu (Figure 3.6).

2. When the Find Files window opens click the
Options Menu arrow in the upper right hand
corner.

3. A drop down list of the search options will
appear (Figure 3.7). Choose which file type you
want to search for.

4. After the search has finished, the found files
will be displayed in the Find Files window.

5. Simple drag the files you want to use to the
Project, Editor, or Sequence Windows and they
will automatically be added to your project.
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Figure 3.5 Drag a clip from the Source Window to
the Timeline to add only the media between the In
and Out points you have set.

Figure 3.6 In the File main menu, select
Find File, to have Looking Glass search for
media files.

Figure 3.7 Click on the arrow to reveal the
search options.



Working with graphics
Looking Glass supports several graphic formats.
These include: JPEG, PSD, TIFF, GIF, PNG, BMP
and TGA, among others.  There is no conversion
necessary to use these files, simply drag them into a
project. Looking Glass does support multi-layered
Photoshop (PSD) files.

When graphics are used in the timeline they have no
duration, unlike a movie file. A graphic file can be
as long or as short as you want it to be.

Alpha channels

Looking Glass supports the use of alpha channels in
graphic images. The graphic formats that currently
support alpha channels are TIFF, PSD and PNG. To
use alpha channels with Looking Glass, you will
need to use a graphic editing program like Adobe©
Photoshop© to create the alpha channel, then bring
that file in Looking Glass. 
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Different aspects of working with graphics in
Looking Glass are covered throughout this manual.
For more information on working with titles see
Chapter 6: Creating Effects &
Compositing, for more information on getting
the most out of graphics while working with DV
footage see Appendix A: Working With DV.

More On Graphics 1



Capture
Looking Glass allows you to capture video from a
DV camera/deck, as well as by using a USB device.
This section will deal with capture related issues
you might encounter while trying to digitize your
footage.

Connecting

1. From the File menu choose Capture (Figure
3.8).

2. When the video capture window appears, click
Connect to connect Looking Glass to your DV
camera/deck or USB device (Figure 3.9).

Getting an error message

If you get an error message trying to connect
(Figure 3.10), then either your device was not
properly connected to your Mac, or it was not
turned on.

a. Check to see if you plugged the FireWire cable
or USB device correctly into the back of your
camera/deck and the back of your Mac. Refer to
Appendix E: Connecting Capture
Devices for help with this.

b. If your device is connected, make sure it is
turned on. If it is a camera, make sure the
camera is set to VCR, not camera.

c. After you make these corrections, close the
Capture Video window and try again.
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Figure 3.8 Choose File >
Capture to digitize media.

Figure 3.9 Click Connect to connect Looking Glass
to your camera or deck.

Figure 3.10 This error message means
your device was not turned on or not
connected.

This chapter deals with capture issues involving the Looking Glass software. For general information regarding
connecting DV camera/decks, and USB capture devices to your Macintosh computer please refer to Appendix
E: Connecting Capture Devices.

Connecting Capture Devices To You Computer



It is important to make sure Looking Glass is
connecting through the correct port to the video
source. The three possible ways to connect a device
to your computer are DV port, USB capture device,
and a 3rd party capture card. Usually, by default,
Looking Glass will choose the correct port to
digitize video from, but its always a good idea to
double check and make sure.

For example, if you have a 3rd party capture card in
your computer, but are going to import video via
FireWire it’s important to let Looking Glass know.

To change which port is being
accessed

1. From the File main menu, choose Capture.

2. Push Connect in the Capture Video window.

3. Next, click on the Video button (Figure 3.11).

4. In the Video window, choose Source from the
top-most drop down menu (Figure 3.12).

5. In the Source section, click on the menu next to
Digitizer (Figure 3.13) and choose the proper
port. For capturing via FireWire choose DV
Video, for USB capture devices choose USB,
and for any 3rd party card choose that card.
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Figure 3.11 Click the button labeled Video in order to
set the correct port.

Figure 3.12 Choose Source from the drop down
menu, in the Video window.

Figure 3.13 Next to Digitizer, choose the correct
port.



Choosing capture options

After you’ve connected to your camera or deck, its
time to choose your capturing options before
digitizing begins.

Deciding what to capture

You can choose to capture both video and
audio, audio only, or video only.

1. There are two check boxes in the Capture Video
window. These boxes are labeled Record Video
and Record Audio.

2. To not record something, uncheck the box.
Figure 3.14 shows the Record Audio box being
unchecked so only video will be recorded.

Adding captured clips to projects

By default, all captured clips are adding
immediately to the current project. You can turn
this off if you want.

1. Uncheck the box labeled Add To Project in the
Capture Video Window.

Saving captured files

1. When you are done capturing footage, click
anywhere in the Capture Video window.

2. A dialog box will pop up asking for you to
name the file just captured, and locate a folder
to place it in.

3. When you click Save, the captured file is saved
to your computer and added to the current
Looking Glass project.
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Figure 3.14 You can choose to record video or audio
only by unchecking the boxes next to Record Video
and Record Audio.



Editing A Movie

This chapter will introduce you to editing
terminology, and the editing functions found
in Looking Glass.

• About Non-Linear editing

• What’s a sequence?

• Basic editing step by step

• Advanced editing step by step

• Annotations

With digitized footage saved on your computer, and a general knowledge of how Looking Glass
works, its time to begin editing. Even if you’ve never edited before, Looking Glass is simple
and intuitive. This chapter is designed to be a non-technical explanation of basic editing

functions and terms, easily accessible to the beginner.
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About Non-linear
editing
As a digital, non-linear editing tool, Looking Glass
provides complete random access to footage, with
instantaneous cuing and retrieval of sequences,
segments, shots, and frames.

Looking Glass provides great freedom from the
constraints of traditional editing. Its non-linear
editing features allow you to make changes, and the
entire sequence is immediately updated. Looking
Glass maintains frame-accurate links between each
alteration of the objects you work with and the
original media files. This allows you to experiment
with every edit you make through multiple
generations. When you play back your work, the
system immediately accesses and plays the
appropriate portions of the digitized video and
audio.

What’s a sequence?
A sequence is an series of video and audio clips that
have been edited together. A sequence is part of a
project, and you can have multiple sequences per
project. When you export a finished movie, you
export one sequence at a time into a self-contained
file.

Creating a new sequence

When you create a new project, a new sequence is
automatically generated in that project. If you want
to create a new sequence on your own:

1. Make sure a project is open.

2. Select Sequence from the main menu, and
choose New...(Figure 4.1).

3. Name the sequence and select the media type
you will be using then click OK (Figure 4.2).

4. The new sequence will appear in the active
project window.
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Figure 4.1 Create a new sequence by
selecting Sequence > New.

Figure 4.2 Enter in a sequence name, and select
your media type in the Sequence Settings Window.



To open a sequence for editing

1. Open the project that contains the sequence you
want to work on.

2. Double-click the sequence you want to edit in
the Project Window (Figure 4.3). 

To duplicate a sequence

1. Click on the sequence you want to duplicate in
the Project Window.

2. From the Edit main menu, select
Duplicate(Figure 4.4). 

3. A copy of the sequence will be made and
placed in the Project Window.

Deciding which tracks receive new
media

When adding a clip to the a sequence, you can
either add the clip to an existing track, or create a
new track.

To create a new track in the timeline

• Drag the clip into the Editor Window

• Drag the clip to the left-hand side of the
timeline under the transport controls (Figure
4.5).

To add a clip to an existing track

• Drag a clip from the desktop, Project Window,
or Source Window anywhere into an existing
track and the new clip will be added to it.
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Figure 4.3 Double-click on a sequence in the
Project Window to open it for editing.

Figure 4.4 Use the Duplicate command
in the Edit menu to duplicate a selected
item.

Figure 4.5 Drag a clip into the area under the
transport controls in the Sequence Window to create
a new track.



Basic editing step by
step

Bringing media into the timeline

Media can be placed into the timeline from the
Project Window, Source Window, or your computer
desktop (Figure 4.6). 

To learn more about setting In and Out points on
media in the Source Window see Chapter 2:
Welcome To Looking Glass. Placing media
from the Source Window into the timeline is
discussed in Chapter 3: Bringing Media
Into A Project.

Deleting clips from a sequence

There are two ways of deleting clips from a
sequence.

• Deleting in Overlay mode removes the clip and
leaves a gap where the clip was.

• Deleting in Insert mode removes the clip and
closes up the space where the clip was, brining
the surrounding media in that track together.

To perform an Overlay delete

1. Make sure the track you will be working in is
in the Overlay mode. Click in the Insert /
Overlay button until it is in the Overlay position
(Figure 4.7).

2. Click on the track you want to delete (Figure
4.8).

3. Push the Delete key on your keyboard.

4. The clip will be removed, leaving a gap where
it used to be (Figure 4.9).
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Figure 4.6 Here, a file is being dropped into the
Sequence Window from the desktop.

Figure 4.7 Click the Overlay/Insert button to put a
track into Overlay mode.

Figure 4.8 The clip to be deleted is selected in the
timeline just before the Overlay delete.

Figure 4.9 The timeline just after the Overlay delete
is performed.



To perform an Insert delete

1. Make sure the track you will be working in is
in the Insert mode. Click in the Insert / Overlay
button until it is in the Insert position (Figure
4.10).

2. Click on the track you want to delete (Figure
4.11).

3. Push the Delete key on your keyboard.

4. The clip will be removed, closing in the gap
where it used to be (Figure 4.12).
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Figure 4.10 Click the Overlay/Insert button to put a
track into Insert mode.

Figure 4.11 The clip to be deleted is selected in the
timeline just before the Insert delete.

Figure 4.12 The timeline just after the Insert delete
is performed.



Trimming clips

Each basic trimming type solves a particular editing
problem, and familiarizing yourself with them all
will be beneficial.

Trim Editing Window

Before getting into the editing functions of
Looking Glass, it’s important to know about the
Trim Editing Window. The Trim Editing
Window assists in making precise frame-
specific changes to a clip’s In/Out points. 

Whenever a clip is being edited in the Sequence
Window, the Editing Preview Window pops up,
displays what the clip’s I/O points as they
change.

• Figure 4.13 shows the Trim Edit Windows.
The left window is displaying the end frame of
the clip on the left, and the right window is
displaying the starting frame for the clip on the
right. The numbers in the upper left hand corner
of the windows tell how many frames have
been added or shaved off during the edit. The
inverted bar in the right Trim Edit Window
signifies that you are at the beginning (or end)
of that clip’s footage, and can’t add (or subtract)
anymore.

Roller & Roller Cursors

Looking Glass uses a roller and a roller cursor
to perform special edits. Clicking near the
inside edges of the beginning or end of a clip
will make a red bar appear. These are called
Rollers. When you move the cursor over a
Roller, it changes into a Roller Cursor (Figure
4.14). You can only manipulate the Rollers
when the Roller cursor is displayed. To turn the
Rollers off, click anywhere in the Timeline.

QuickTrim

The QuickTrim is the basic editing feature in
Looking Glass. It’s the simplest, fastest way to
make adjustments to a clip’s In or Out point.
QuickTrim adjusts the In or Out point of one
clip without affecting the adjacent media.

1. Grab either the beginning or end of a clip. This
will give you the QuickTrim cursor (Figure
4.14).

2. Drag either to the left or right to lengthen or
shorten the clip.
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Figure 4.13 The Trim Editing Windows appear when
you adjust the In or Out points of a clip.

Figure 4.14 Clicking near the
inside of the front or back of a
clip activates the rollers.

Figure 4.14 The QuickTrim
cursor appears when you grab
the beginning or end of a clip.



Ripple Edit

In a ripple edit, you change the duration of one
clip but do not affect the duration of adjacent
clips. This is done by activating a Roller on one
end of a single clip, and using the Roller Cursor
to to either lengthen or shorten that clip. When
a ripple edit is performed all clips in that track
change position in the timeline.

1. First, activate a roller on the end of the clip you
want to perform the edit on (Figure 4.15).

2. Drag to the left or right to lengthen or shorten
the clip.

3. The clip will change duration, but the adjacent
clips will not (Figure 4.16).

Roller Trim

In a roller trim you change the out point of one
clip while you change the in point of the
adjacent clip. You make one clip shorter while
you make another clip longer, so the total length
of the sequence stays the same.

1. First, activate a roller on the two clips that you
want to edit (Figure 4.17).

2. Drag to the left or right to lengthen or shorten
the clip.

3. The two clips will change duration, but the
adjacent clips will not, leaving the length of the
sequence the same (Figure 4.18).
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Figure 4.15 The two clips before a ripple
edit is performed. Notice their duration
and position in the timeline.

Figure 4.16 After the ripple edit the
second clip’s duration did not change,
only its position.

Figure 4.17 Before the Roller Trim: notice the
sequence duration and clip placement.

Figure 4.18 After the Roller Trim, the position of
the last clip doesn’t change.



Using Grey Bars

Grey Bars are a feature unique to Looking
Glass. Grey Bars allow you to grab blank space
in the timeline and shuffle it around just as if it
were a clip. The grey spaces that are movable
are any area before a clip (Figure 4.19), and
any area between clips (Figure 4.19). The grey
space after the last clip in a track is not
grabbable.

Grey Bars have set behaviors depending on the
mode you are in.

Using Grey Bars in Overlay mode

In overlay mode, the grey bars will overwrite
whatever media they are placed over.

1. Figure 4.21 shows the grey bar being
selected while the timeline is Overlay
mode.

2. When the Grey Bar is moved (Figure 4.22)
not only does it overwrite the media it is
dropped on, but the timeline retains the
space where the Grey Bar used to be. 
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Figure 4.19 The grey space
is selected in front of the clip.

Figure 4.20 The grey space is selected
in between the two clips.

Figure 4.21 The grey space is selected, ready to be
moved.

Figure 4.22 When moved between the clips, the
grey space overwrote the media it was set on top of.



Using Grey Bars in Insert mode

In insert mode, the grey bars will not overwrite
whatever media they are placed over.

1. Figure 4.23 shows the grey bar being
selected while the timeline is Insert mode.

2. When the Grey Bar is moved (Figure 4.24)
it doesn’t overwrite any media, it simple
splits whatever it moves between. The gap
where the Grey Bar used to be is also
deleted, sliding the entire sequence to the
left.

Positioning the Scrubber in the
sequence

The Scrubber is a thin grey line that allows you to
navigate through a sequence.

Navigate by scrubbing

Scrubbing is the act of grabbing the Scrub bar
with your mouse and dragging it back and forth
in the timeline. 

1. To scrub through a sequence simply click
anywhere in the white timeline area of the
Sequence Window  (Figure 4.25).

2. Then, holding down the mouse button, drag to
the left or right to scrub through a sequence.

Move to keyframe

You can advance the scrubber from keyframe to
keyframe by using the keyframe controls.

1. To move to the next and previous keyframes in
a sequence first roll open the track the holds the
keyframes.

2. Use the arrows in the keyframe controls to
advance the Scrubber (Figure 4.26).

Move to mark

You can advance the scrubber from mark to
mark by using the mark controls.

1. Click Next Mark in the Editor or Sequence
Windows to advance the Scrubber to the next
mark in the timeline (Figure 4.27).

2. Click the Previous Mark in the Editor or
Sequence Windows to Advance the Scrubber to
the previous mark in the timeline (Figure 4.28).
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Figure 4.23 The grey space is selected, ready to be
moved.

Figure 4.24 After moving, the Grey Bar simply slides
between the two clips, not overwriting any media.

Figure 4.25 Click anywhere in the white timeline
area to begin scrubbing.

Figure 4.26 Click on the arrows by the X in
they keyframe controls box will move the
Scrubber to the next and previous keyframes.

Figure 4.28 Click the Previous Mark button to go to
the previous mark in the sequence.

Figure 4.27 Click the Next Mark button to go to the
next mark in the sequence.



Advanced editing step
by step

Insert and Overlay mode

Insert and Overlay mode determine how the clips
effect each other in a track. You can toggle between
Insert and Overlay mode using the track controls, as
shown inFigure 4.29 and Figure 4.30.

Insert edit

When Insert mode is turned on media cannot
overwrite other media directly. In this mode
when a clip is inserted into the timeline all
subsequent clips are shifted in time to make
room for the new clip. If the insertion point
occurs at a point that is already occupied by
media, the media is split to make room for the
new clip. 

• Figure 4.31 shows a clip before the edit takes
place.

• Figure 4.32 shows the clip after the Insert edit.
Notice how the clip was split, and shifted in the
timeline to make room for the new piece of
media.

Overlay edit

When Overlay mode is turned on, any media
added to the timeline will replace whatever
information they are added over.

• Figure 4.31 shows a clip before the edit takes
place.

• Figure 4.33 shows the clip after the Overlay
edit. Notice how the clip was overwritten at the
edit point, keeping the sequence the same
overall length.
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Figure 4.29 In Overlay Edit mode.

Figure 4.30 In Insert Edit mode.

Figure 4.31 The clip before any edits.

Figure 4.32 After the Insert edit. Notice the clip was
split at the edit point, changing the duration of the
sequence.

Figure 4.33 After the Overly edit. Notice the clip was
overwritten at the edit point, and there was no
change to the duration of the sequence.



Slip edit

A slip edit is used to adjust both the in and out
points of a clip at the same time, while keeping its
length in the timeline the same. To perform a slip
edit there must be extra footage at the end and the
beginning of the clip. A slip edit does not alter any
adjacent media.

1. To preform a slip edit, hold down the Control
key on your keyboard and click on the clip you
want to edit.

2. Trim Edit Windows will appear, showing you
the last frame and first frame of the adjacent
clips, and the start and end frame of the clip
being edited (Figure 4.34).
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Figure 4.34 When you perform a a slip edit, Trim Edit Windows show you the first and last frame of the clip
being adjusted. No other clips are affected.



Split clip

The Split Clip feature is used to cut the currently
selected clip in two. It can be especially useful when
editing audio only tracks such as voice-overs and
narration.

1. Select the clip in the Timeline you want to cut
by clicking on it (Figure 4.35). 

2. Move the Scrubber to where you want to make
the cut.

3. Select Split Clip from the Sequence main menu,
or push Command-E on your keyboard(Figure
4.36 & Figure 4.37).
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Figure 4.36 Select Split Clip from the Edit main
menu, or push Command-E.

Figure 4.35 Select the clip you want to
cut by clicking on it.

Figure 4.37 Select Split Clip from the
Edit menu and the clip will be cut at
the Scrubber’s position.



Basic 3-point editing

Looking Glass allows you to preform basic 3-point
editing from the Source Window to the Sequence
Window.

3-point editing allows you to add specified portion
of a clip into the active sequence.

1. Double-click on the clip in the Project Window,
opening it in the Source Window.

2. Set In and Out points around the section of the
click you want to add to the sequence.

3. In the Sequence Window, set an In point where
you want the clip to come in at (Figure 4.38). If
there is no In point set, the clip will be added at
the Scrubber’s current location.

4. In the Sequence Window, select the track you
would like the clip to in at. If not track is
selected a new track will be created.

5. If the clip will be added to a currently existing
track, set that track’s edit mode to Overlay or
Insert (Figure 4.39).

6. In the Source Window, hit the B key.  The clip
will be added to active Sequence Window. If no
Sequence Window is open, a error will be
presented (Figure 4.40).

7. The new clip will be added to the sequence
(Figure 4.41).
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Figure 4.38 Set an In point where you would like the
clip to come in at.

Figure 4.40 If no Sequence Windows are open,
Looking Glass will present an error that the edit
could not be completed.

Figure 4.41 The portion of the clip you specified will
be added to a new track.

Figure 4.39 If the clip is to be added to an existing
track, decide whether to have the track set to
Overlay or Insert mode.



Using Text files
Text can play an important role in your movies. It
can serve as titles, credits or sub-titles. Looking
Glass has the power to use QuickTime’s ability read
a plain text file and use the text present in the file in
a QuickTime movie. Using certain tags in a text file
you can change the font, change the color, add a
drop shadow, even key the text on top of the video.
Also, since text is in vector format, when the final
movie is resized the text will will resize with the
movie.

Text descriptors and rules

Looking Glass reads certain descriptors put into the
text file to know which way to scroll the text, what
font to give it, etc. 

Figure 4.42 is a sample of what a text document can
look like. As you can see all text descriptors are
enclosed with braces ( { and } ).  The timestamp
information is enclosed in brackets ( [ and ] ). Also,
all files must start with the descriptor {QTtext}.
This can then be followed by any number of text
descriptors, in any order. You can change the format
at any time by inserting a new text descriptor. For
example, inserting {plain} halfway through your
document will override a previous settings of
{bold}. There is no case sensitivity, and if you have
a spelling error, it might not play correctly. 

Text Descriptors

{QTtext}

This is required at the start of any file that has
descriptors or timeStamps. If this is not the first
thing in the file, the file is assumed to be
normal text.

{font: fontname} 

The parameter is the name of the font. Example:
{font:Apple Chancery} This will change all text
after the descriptor to the Apple Chancery. The
person who is playing the movie must have this
font installed for it to display correctly, so be
sure to choose common fonts.
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 {QTtext} {font:Ariel}
 {bold} {size:10}
 {width:320} {height:240}
 {timeStamps:absolute}
 [00:00:00.00]
 Once upon a time
 [00:00:05.00]
 there lived a brilliant editor
 [00:00:06.00]
 who stayed up late into the night
 [00:00:07.00]
 working on his masterpiece...

Figure 4.42 Text document sample.



{ fontstyle}

This specifies the style of the text that follows.
There are eight valid font styles:

{plain} Plain text.

{bold} Bold text.

{italic} Italic text.

{underline} Underlined text.

{outline} Outlined text.

{shadow} Text with a drop shadow.

{condense} Text with spacing between
characters decreased.

{extend} Text with spacing between characters
increased.

{justify: alignment}

This specifies the alignment of the text that
follows. There are four valid parameters for
justify:

{justify:left} Text will be aligned flush left.

{justify:right} Text will be aligned flush right.

{justify:center} Text will be centered.

{justify:default} Text will align to whatever the
script system has set.

{size: pointsize}

This is the point size of the text. {size:18} will
set the point size of text that follows to 18
point.

{textColor: redvalue , greenvalue ,
bluevalue}

To set the color of the text. There are three
numbers between 0 and 65535 that make up the
parameters. These numbers are RGBColor
values. The order is red, green, blue. The values
are separated by a comma ','. For example,
{textColor: 0, 0, 65535} is blue text,
{textColor: 65535, 32000, 0} is orange.

{backColor: redvalue , greenvalue ,
bluevalue}

This is the same as textColor except that it
changes the background color.
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{height: texttrackHeightInPixels}

Takes one parameter, the height of the text track
in pixels. {height:50} will set the text track
height to 50. A value of zero will set the height
to the best fit for the contents.

{width: texttrackWidthInPixels} 

Same as height except a value of zero will set
the width to 240 or to that of the movie if
importing into a movie.

{language: languageNumber} 

Text tracks can be set to a specific language.
The ordinal (numeric) value of the language is
used instead of the actual name. Example:
{language:11} sets the language of the track to
Japanese.

{timeStamps: relativeOrAbsolute}

Specifies if the timeStamps that follow are
absolute or relative.

{timestamps:absolute} the timeStamps show the
time the samples start relative to the beginning
of the track. Note that since a track may not
start at the beginning of a movie, this may not
always (although it usually does) imply time
relative to the start of the movie.

{timeStamps:relative} The timeStamps show
the time relative to the previous sample.



{timeScale: numberPerSecond}

Think of this as the fractional part of a second.
Ordinarily, people used to thinking about NTSC
video probably think in 30ths of a second, while
people used to film may think in 24ths of a
second. So NTSC video users would specify a
timescale of 30, while film animators would
probably use a timescale of 24.

QuickTime expresses times based on a
timescale of 30. If you are working with
QuickTime, you will probably want to use a
timescale of 30.

The number of digits in the last value of a
timestamp is determined by the timescale. If
{timeScale:10}, then the timestamp for 7.5
seconds would be ' [00:00:07.5] '. But If
{timeScale:1000} , the same 7.5 seconds would
be written as ' [00:00:07.500] '. The timeScale
cannot go over 1000.

{textBox: top , left , bottom , right}

Used to set the dimensions and location of the
textBox relative to the other visible tracks.
Example: {textBox:0, 0, 80, 320} will draw the
text in an 80-pixel-high by 320-pixel-wide box
at the the top left of the movie window.

{anti-alias: onOrOff} 

Display text anti-aliased. While anti-aliased text
looks nicer, it incurs a significant performance
penalty.

{keyedText: onOrOff}

Render text over the background without
drawing the background color. This technique is
otherwise known as "Masked Text."

{doNotDisplay: onOrOff}

QuickTime will not display the text after
{doNotDisplay:off} . Kind of like commenting
text out. To turn text display back on, use
{doNotDisplay:on}. 
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{doNotAutoScale: onOrOff}

QuickTime will not scale the text following
{doNotAutoScale:off} if the track bounds
increase. To re-enable autoscaling, use
{doNotAutoScale:on}. 

{clipToTextBox: onOrOff}

Clips to just the text box. (This is useful if the
text overlays the video, more of the video will
be displayed during shorter text samples)

{useMovieBackColor: onOrOff}

Use the backColor of the movie instead of its
own.

{shrinkTextBox: onOrOff} 

Recalculates size of the textBox parameter to
just fit the given text and stores this rectangle
with the text data.

{scrollDelay}

{scrollDelay: 600} will cause subsequent text to
be delayed one second (if the movie has a
timescale of 600) before beginning to scroll.
This only works when {scrolling:on} has been
specified.

{scrollIn: onOrOff} 

Scrolls the text in until the last of the text is in
view. This flag is associated with the
scrollDelay parameter.

{scrollOut: onOrOff} 

Scrolls text out until the last of the text is out of
view. This flag is associated with the
scrollDelay parameter. If both scrollIn and
scrollOut are set, the text is scrolled in, then
out.

{horizontalScroll: onOrOff}

Scrolls a single line of text horizontally. If the
horizontalScroll flag is not set, then the
scrolling is vertical.



{reverseScroll: onOrOff} 

If set, scrolls vertically down, rather than up. If
not set, horizontal scrolling proceeds toward the
left rather than toward the right.

{continuousScroll: onOrOff}

New samples will cause previous samples to
scroll out (scrollIn and/or scrollOut must also
be set for this to take effect).

{flowHorizontal: onOrOff}

Lets horizontally scrolled text flow within the
text box. This behavior contrasts with letting
text flow as if the text box had no right edge.

{hilite: firstcharacter , lastcharacter}

Usedfor hiliting text. The parameters are first
and last character to hilite in the text that
follows. Example "{hilite: 11, 14} This is a text
track" hilites the word 'text' in "This is a text
track" sample.

{hiliteColor} 

Use this to change the color used in highliting.
The order of the parameters is red, green, blue.
Example: {hiliteColor:35000, 0, 0} sets the
hilite color to a shade of red.

{inverseHilite: onOrOff} 

Use inverse hiliting rather than hilitecolor .

{dropShadow: onOrOff} 

Support true drop shadows. Using
SetTextSampleData, the position and
translucency of the drop shadow is under
application control. Not the same as {shadow}. 

{dropShadowOffset} 

{dropShadowOffset: 3, 4} will offset the text
shadow 3 pixels to theright and 4 pixels down.
Only works when {dropShadow:on} has been
specified.
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{dropShadowTransparency}

Pass in a value between 0 and 255. Changes the
intensity of the drop shadow. Example:
{dropShadowTransparency: 127}.



Creating a text file

Creating a text file is simple. If you are in OS 9,
SimpleText will work. If you are in OS X, at the
time of this writing, the default OS X text editor,
TextEdit.app did not produce usable plain text file.
For this reason Microsoft Word or AppleWorks is
preferrable.

To create a text file

1. Type a QTtext document in the text editor of
your choice.

2. When it is time to save it, be sure to choose
Save As from the File main menu.

3. In the Save As dialog box, follow your text
editor’s manual and choose Plain Text or Text
Only as the file format.

SimpleText only saves documents in plain text
format, so no extra steps are necessary.

Adding a text file to a Looking Glass
movie

Once you have a fin ished text file, follow these
steps:

1. Drag the text file into the Project Window.

2. Double-click on it in the Project Window to
preview it in the Source Window.

It is important to note that a text file will only retain
is descriptors and timestamps if it is rendered out
using Make Movie. If you put a text file into a
sequence and render out the sequence using Export
Movie then the text filewill not display properly in
the finished movie.

Using Make Movie and Export with text files

1. Finish editing the sequence in the Sequence
Window. Do not add any text files to the
sequence yet.

2. Use Export Movie from the File main menu
and save your sequence to a QuickTime movie
file. Compress the sequence using the codecs
you desire for final viewing.

3. Click the Project Window to make sure it is
active and from the Sequence main menu, select
New (Figure 4.43).

(continued)
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Figure 4.43 Choose to make a new
sequence from the Sequence main menu.



4. Double-click on the new sequence in the
Project Window to open it up.

5. Drag the movie you just exported from the
Project Window into the new sequence.

6. Drag the text file from the Project Window into
a new track above the exported movie in the
sequence. Make sure the text file lines up how
you want it with the movie (Figure 4.44).

7. When you’re finished choose Make Movie from
the File main menu.

8. Choose a save location for the file.

9. When the Compression Settings dialog box
appears choose Use Default Settings. Make sure
both the Video and Sound boxes are checked
(Figure 4.45).
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Figure 4.44 Line the text file up how you want.

Figure 4.45 Choose ‘Use Default Settings’ and make
sure that both Video and Sound are checked.



Render Preview
Looking Glass gives you the ability to preview your
sequence in the format that you will be exporting it
to. More than just allowing you to see how a
transition will look when exported, this feature
allows you to also see how your sequence will look
using the size and codec you plan on applying to it.

For example, if you are working with DV video but
will exporting the finished product out for web use
using a 320 x 240 size and the Sorenson compressor
codec, Render Preview will render out the sequence
with those settings and make a temporary file that
allows you  to see how it would look.

To set a Render Preview Folder

When you use the Render Preview function,
Looking Glass places the preview file in a folder on
your computer. Before using the Render Preview
function you need to set a folder.

1. In the File main menu, choose Set Preview
Folder (Figure 4.46).

2. Choose a folder on your computer to use as the
Render Preview folder and click choose. 

To use Render Preview

1. Click on the Editor or Sequence window to
make one of them the active window.

2. Select Render Preview from the Sequence main
menu (Figure 4.47).

3. You can choose one of the predefined settings
in the drop down menu that appears, or you can
choose Other... to specify your own.

4. Looking Glass will build a preview (this might
take a long time) and insert the file into your
current sequence.

5. Simply place the sequence to view how your
finished movie will look.

6. Delete the track holding the render preview to
continue editing.

You can also set In and Out points in your sequence
and Render Preview will render out only the video
that is within those points.
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Figure 4.46 Choose Set Preview Folder
in the File main menu to select a folder
for the Render Preview files to go to.

Figure 4.47 Choose Render Preview from the
Sequence main menu, then decide on the settings.



Annotations
An annotation is text information about about
certain properties of a movie, such as creation date
and author. Annotations can be stored within all
QuickTime movies.

It’s important to add this information so viewers can
find out about the movie’s background, copyright
ownership, title, etc.

Looking Glass allows you to apply annotations to
the project you are working with and embed those
annotations into your file, whether you choose to
use the Export or Make Movie feature. The
annotations available are:
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• Album

• Artist

• Author

• Comment

• Composer

• Copyright

• Creation Date

• Description

• Director

• Disclaimer

• Encoded By

• Full Name

• Genre

• Host Computer

• Information

•Make

• Model

• Original Artist

• Original Format

• Original Source

• Performers

• Producer

• Product

• Software

• Special Playback

Requirements

• Track

• URL Link

• Warning

• Writer 



Applying Annotations

1. Click on the sequence you want to annotate in
the Project Window.

2. Under the Sequence main menu, select
Annotate (Figure 4.48).

3. In the ‘Sequence Annotations’ window, click
‘Add’ to add a new annotation. A list of
available annotations will appear. There can
only be one instance of each annotation per
movie (Figure 4.49).

4. Enter a description in the text box for the
annotation you have chosen (Figure 4.50).

5. After the text is entered click ‘Ok’ and the
annotation will be added to that sequence in
Looking Glass.
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Figure 4.48 Select Annotate from the
Sequence main menu.

Figure 4.49 Click Add to add an annotation.

Figure 4.50 Pick an annotation
and enter a description for it.



Editing Annotations

1. Click on the sequence that you would like to
edit the annotation for in the Project Window.

2. Choose Annotate in the Edit main menu.

3. Highlight the annotation to be edited, and click
Edit (Figure 4.51).

Deleting Annotations

1. Click on the sequence that you would like to
delete the annotation for in the Project Window.

2. Choose Annotate in the Edit main menu.

3. Highlight the annotation you want to delete,
then click the Delete button (Figure 4.52).
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Figure 4.51 Highlight the annotation to be edited,
then click Edit and change the description.

Figure 4.52 Highlight the annotation to be delete,
then click Delete. 



Viewing Annotations

Looking Glass

1. Select the sequence you want to view the
annotations for in the Project Window.

2. Push -I on your keyboard to open the Info
Window.

3. Click the triangle in the upper right hand corner
of the Info Window (Figure 4.53).

4. The annotations for that sequence will appear.

QuickTime 4

1. Open the movie in QuickTime Player

2. Push -I to open the Info Window.

QuickTime 5

1. Open the movie in QuickTime Player.

2. Push -I to open the Info Window to view the
first six annotations.

3. Push -J to open the Properties Window and
view all annotations.

Saving Annotations to a movie

Saving annotations to a QuickTime movie from
Looking Glass is simple. Whenever you render out a
finished project with the Export or Make Movie
command, any annotations you added will
automatically be embedded into the file.
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Figure 4.53 Click the triangle in the Info Window
to view annotation information.



Creating
Transitions

There’s more to Looking Glass than just
editing. In this chapter you’ll learn about:

• Transitions

• Adding Transitions

• Editing Transition Properties

• Effects of editing on transitions

• Deleting Transitions

You can add life to a project by using transitions, titles, and other effects. Looking Glass supports
all the transitions that QuickTime’s powerful engine has to offer. This chapter will walk you
through how to add, edit, and delete transitions from your movie.
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Transitions
A transition is the visual change from one clip to the
next. There are many types of transitions. The most
common is the cut. Looking Glass is powered off of
Apple’s QuickTime engine, so it is capable of
handling every transitions that QuickTime can. To
learn more about QuickTime’s capabilities visit
http://www.apple.com/quicktime.

To open the Transitions Window (Figure 5.3)., use
one of these three ways: 

• Click the Options Menu in the Project Window
and select Transitions Window in the drop down
menu (Figure 5.1). 

• Select Windows in the main menu and choose
Transitions Window (Figure 5.2). 

• Press -T

There are some rules to remember when working
with transitions. They are:

• The clips must be on the same track and directly
against each other (Figure 5.4).

• There must be at least 15 extra frames on the
tail of the first clip and the head of the second
clip. You might have to QuickTrim the clips to
allow the transition enough room.

Adding transitions
Transitions are added by dragging them from the
Transitions Window and placed on the bordering
edges of two adjacent clips in the Sequence
Window. 

• Drag a transition from the Transition Window
into the Sequence Window, and drop the
transition on the bordering edges of two
adjacent clips.
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Figure 5.1 You can open the Transitions
Window from the Project Window Options
Menu.

Figure 5.2 You can also open the Transitions
Window from the Windows main menu.

Figure 5.4 Two clips must be
adjacent before a transition can be
added,

Figure 5.3 The Transitions Window.



Editing transition
properties
To access a transition’s properties: 

1. Click the arrow to the left of the Track name. 

2. Next,  click the arrow to the left of the
transition (Figure 5.5).

3. The transition controls will appear (Figure 5.6).

The transition control panel is made up of four main
segments: Type, Duration, Input 1 and Input 2. 

• Type: Shows which transition you chose. The
pull down menu to the right allows you to
choose another. Also, some transitions, such as
Wipe have multiple variations. To access these
variations double-click on the name of the
transition type. A dialog box will pop up
allowing you to fine tune your transition effect.

• Duration: Shows the entire duration of the
transition from start to finish. This can be
changed by clicking once on the duration
number and entering in a new one. Note: To
make a transition longer you must have the
appropriate amount of extra footage for each
clip.

• Input 1 and Input 2: Show which clips are
being used in the transition and the duration for
the transition on each clip.

To replace transition type

You can change the type of transition you are using,
even after you have applied it. 

1. Open the transition control panel.

2. Click the arrow next to the transition’s name
and a drop down box will appear allowing you
to change the type of transition you are using
(Figure 5.7).
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Figure 5.5 Click the arrow by the track
name to reveal the transition, then click the
arrow by the transition to reveal its controls.

Figure 5.6 The transition controls.

Figure 5.7 Clicking the arrow next to the transition’s
name lets you change transition type.



To edit time duration

The duration of a transition can be edited after it is
applied. 

1. Open the transition control panel.

2. Click on the duration frame number (Figure
5.8).

3. Type in a new duration and push Enter. The
transition will be divided equally between the
two clips (Figure 5.9).

Effect of editing on
transitions
After a transition has been applied two clips, certain
edits on those clip will affect the transition. 

• Moving the clips away from each other will
delete the transitions.

• QuickTrimming the adjacent edges of the clips
will delete the transition.

Deleting Transitions
• To delete a transition simple open up the

transition control panel, click on the transition
name to select it and push the delete key.
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Figure 5.8 Click on the frame duration
number in order to change it.

Figure 5.9 After you type in a new duration,
push Enter for it to take effect.



Creating Effects
& Compositing

In this chapter you’ll learn about:

• Working with keyframes in the timeline

• Titling

• Viewing Actual DV size

• Adding freeze frames

Looking Glass allows you to keyframe certain effects over time, giving your movies a dynamic,
professional quality. This chapter will describe all the keyframing capabilities that Looking Glass
offers, as well as explain the best ways to apply titles to your movies, and adding freeze frames.
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Working with
keyframes in the
timeline
Keyframes indicate that an effect parameter is
changing over time. A keyframe is created at a place
where you want to change the value of an effect’s
parameters, like an edit point.

The clip effects that are keyframeable are Size,
Position,  Anchor, and Audio Gain.

Using the keyframe controls

Keyframes have their own controls. They
appear to the right of the clip effect controls
(Figure 6.1). Clicking the box while it is empty
like in Figure 6.1 will set a keyframe at the
Scrubber’s present location with the current
effect values. 

When a keyframe is present the arrows on either
side of the box will become dark. They are used
to jump the timeline Scrubber from one
keyframe to the next. When an X is present in
the box, the Scrubber is resting on a keyframe.
Clicking the X would then delete the keyframe
(Figure 6.2).

Setting keyframes

Using clip effects control panels

1. Open the effect you want to adjust by
clicking the arrow next to the effect name.

2. Move the scrubber where you would like to
place the first keyframe.

3. Enter the value you want in the effect
control panel.Figure 6.3 shows a new gain
value being typed into the Audio effects
control panel. 

4. Push Enter after you type in the value you
want and a keyframe will be set (Figure
6.4).
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Figure 6.1 The keyframe controls appear
as a box with an arrow on either side to the
right of the effect controls. Clicking the box
will set a keyframe with the current values.

Figure 6.2 When an X is inside the box, it
means the Scrubber is resting on a
keyframe. Clicking the X will delete the
keyframe.

Figure 6.3 Here, a new gain value is being
typed in. 

Figure 6.4 Push Enter after typing in the
value you want, and a keyframe will be set.



Moving objects in the Edit Window

The Size, Anchor and Position effects can be
altered by moving the clip inside the Edit
Window

1. In the timeline, select the clip you want to alter
by clicking on it.

2. If you will be changing the size of the clip,
make sure the Object Handles are turned on by
using the Editor Window Options Menu (Figure
6.5).

3. Move the Scrubber to the point in the timeline
that you would like to set a keyframe.

4. To change the size of the clip, grab the object
handles and make adjustments. A keyframe will
be set (Figure 6.6).

5. To change the position or anchor of the clip,
click in the center of the clip and drag to the
desired location. A keyframe will be set.

Moving keyframes

1. Keyframes appear as diamond icons in the
timeline. Figure 6.7 shows a keyframe being
dragged to the left. Notice it is still visible in its
old location for reference. 

2. Figure 6.8 shows the keyframe in its new
location.
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Figure 6.5 Turn on Object Handles in the
Editor Window Options Menu.

Figure 6.6 Click on the Object Handles and drag to
change the size of a clip.

Figure 6.7 Keyframes appear as diamond
icons in the timeline. Here, a keyframe is
being moved to the left.

Figure 6.8 The keyframe is now in its new
position.



Deleting keyframes

1. Use the arrows in the keyframe controls to
move the Scrubber to the keyframe you want to
delete.

2. When the Scrubber is resting on a keyframe, an
X will appear in the keyframe control box
(Figure 6.9). 

3. When the Scrubber is over the keyframe you
want to delete, click the X and the keyframe
will be removed (Figure 6.10).

To change keyframe parameters

1. Open the clip that contains the keyframe you
want to alter (Figure 6.11).

2. Use the arrows in the keyframe controls to
move the Scrubber to the keyframe you desire
to change.

3. Once at that keyframe you can edit the values
manually, or change the clip in the Editor
Window. They keyframe will automatically
update itself.

Titling
Looking Glass allows you to put titles in your
movies. By using Adobe© Photoshop© or some
other graphics program, you can make titles with
alpha channels that meld seamlessly with your
video.

Creating titles

Titles can be any image file you desire. These can
be made in most graphic editing programs, such as
Adobe Photoshop. If a title does not have Alpha
Channel for transparency however, it will cover the
entire screen. Creating a title with an Alpha Channel
will allow the video beneath the title to show
through. Consult the manual of your graphics
program for how to do this. TIFF, PSD, and PNG
files support Alpha Channels.
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Figure 6.9 An X in the keyframe control box
means the Scrubber is resting on a
keyframe. 

Figure 6.10 The keyframe has been
deleted after clicking the X inside the box.

Figure 6.11 Click on the arrow by the track
name to open a track.



Adding titles to Looking Glass

After you’ve made your title image file, drag it the
Looking Glass Project Window to add it to a
project. Once the title has been placed in the
timeline, position the title and adjust the duration as
you would a normal clip. You cannot fade a title in
or out.

Animating titles

Titles can be animated over time in the Editor
Window. When placing or animating titles in its
important to know about the Safe Titling Area.

Safe Titling Area (STA)

On a computer monitor, text and pictures can be
displayed at the very edge of the screen. This is
not so with a TV set. TV sets cut off the outer
edge of a picture depending mostly on the
televisions age. For this reason the video
industry has come up with the Safe Titling
Area, or STA.

Looking Glass allows you to turn on special
bounding boxes in the Editor window that show
you where the STA is. If you keep your action
and text inside these boxes, they should be
visible on any television.

1. To turn on the STA, click the Options Menu
arrow in the upper right hand corner of the
Editor Window and select Titling and Action
Areas (Figure 6.12).

2. Two yellow bounding boxes will then appear in
the Editor Window. Limit your titles to within
the STA (Figure 6.12).

To animate a title

1. Place the title file in the timeline, arranging it
where you would like.

2. With the scrubber at the beginning of the clip,
position the title in the Editor window to where
you want it to be.

3. Move the scrubber, and re-position the title in
the Editor window. 

4. Repeat this process, this will set a series of
keyframes. When played back in the Editor
Window, the title be animated.
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Figure 6.12 Turn on the STA bounding
boxes by clicking Titling and Action Areas
in the Editor Window’s Option Menu.

Figure 6.13 The STA bounding boxes help you know
where to place and animate titles.



Titling & DV

Understanding how DV size works becomes truly
important when there is a title. If the title in your
project based on a 720 x 480 size, it will be
distorted and “stretched out” when recorded to DV
tape. That’s because, even though 720 x 480 is DV
size on a computer, things are vertically compressed
on purpose. In pixels, the closest approximation a
computer can make to true DV size is use 720 x
540.

There is a solution to this problem. The solution is
to make titles or graphics on a canvas size of 720 x
540, then change the size of the image to 720 x 480.
This will make your title looked compressed, but
when exported to DV tape, it will stretch out to its
normal proportions.
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Different aspects of working with graphics in
Looking Glass are covered throughout this manual.
For more information on what graphic formats
Looking Glass supports see Chapter 3:
Bringing Media Into Projects, for more
information on getting the most out of graphics
while working with DV footage see Appendix A:
Working With DV. Chapter 9: Creating
Final Output discusses how to utilize Make
Movie and Export to create crisp, un-compressed
titles for a finished movie.

More On Graphics 2

DV and Display Size

Unadjusted computer DV size Adjusted with View DV feature

Figure 6.14 DV video displayed on a
computer is compressed vertically.

Figure 6.15 DV video adjusted with the View
DV feature as it would appear on a TV.

DV (digital video) aspect ratio is different on a T.V. screen than on a computer screen. DV size is explained further
in Appendix A: Working With DV. The pictures below demonstrate the differences in DV on a computer and
T.V. Notice that the hoop, a perfectly round image, is displayed properly on a television, but not a computer. 



In the examples below, a title was made on a canvas
size of 720 x 540. It was then changed to an image
size of 720 x 480 in the graphics program. This
made the title look compressed.Figure 6.16 shows
the title over the video in Looking Glass.

After the project was exported out to DV tape and
played on a TV, the video and title were expanded to
their full size as shown in Figure 6.17.
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Figure 6.16 DV image and title at 720 x 480 on a computer monitor.
The title was made at 720 x 540 and compressed down.

Figure 6.17 A DV image and title after being recorded back to DV
tape. The title looks normal.



Viewing actual DV
size
The View DV size feature allows you to quickly
preview your sequence in the Editor Window in a
number of formats to let you see how your video,
graphics and titles will look when expanded to their
full DV size on a T.V.

View DV is a feature, and not a working mode. The
preview lasts until you click anywhere in Looking
Glass.

1. In the Options Menu in the Editor Window
select View DV

2. Choose a format from the drop down menu
(Figure 6.18).

3. Now, whenever you want to preview your
video in its actual DV size select View DV Size
(Figure 6.19), or push Command - / on your
keyboard. You will preview your video in the
format you have specified from step 1.

Adding freeze frames
1. Double-click the clip in the Project

Window so the Source Window opens.

2. Move the Source Window Scrubber to the
frame you want to capture.

3. Select Freeze Frame from the Edit main
menu and choose the duration you want
your image to be. It will automatically
added to your Project as a graphic file
(Figure 6.20).

4. Place the graphic freeze frame into the
Timeline. Remember, you can expand
graphic files to take up as much or as little
time as you like.
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Figure 6.18 From the View DV option in the Editor
Window Options Menu, choose the format you want
to preview your video in.

Figure 6.20  Select Freeze Frame from the Edit
main menu, the choose the duration you want the
freeze frame to be.

Figure 6.19 Choose View DV Size from
the Sequence main menu to preview your
video in DV size.



Multimedia

Looking Glass goes beyond just video, adding
a level of interaction for computer and web-
based media that will be the future of
entertainment. In this chapter you’ll learn
about:

• Specify URL

• Sprites

• Voiceover

Making a video interactive moves your media beyond being merely a movie into becoming a
presentation. Looking Glass allows you to utilize sprites in QuickTime movies,  narrate an
edited movie in real-time, link to reference movies, and more.
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Specify URL
Specify URL allows you to create a reference movie
that, when opened will download and play a movie
from a remote location. 

There are a few rules to remember when using the
Specify URL feature:

• The sequence dummy media file you use in the
sequence as a placeholder cannot have a longer
timeline duration than the remote movie.

• Make sure your sequence and the remote movie
have the same aspect ratio and size.

To use the Specify URL feature, place holder media
needs to be used inside a sequence. Any media will
work as a place holder. The place holder tells
QuickTime how much of the remote file to play, and
what size to play it at.  Keep in mind that
QuickTime will only play as much of the remote file
as the place holder specifies. So, if the remote file is
two minutes long, but the place holder in Looking
Glass was only set to one minute, then QuickTime
will only play one minute of the remote file.

It is important to note that you cannot specify a
certain point in time to play from for a remote
movie. QuickTime will always play from the
beginning of a remote movie.

The Specify Media URL dialog box (Figure 7.3)
lets you choose to pull a remote movie from a web
address (HTTP) or from a local computer (file). The
Auto Play URL check box is marked off by default.
When it is checked and turned on, QuickTime will
automatically download and play the remote media
when it reaches that point in the reference movie.

To use Specify URL
1. Arrange a dummy file inside a sequence to

represent where the remote URL movie will
play (Figure 7.1).

2. Click on the dummy file in the sequence to
select it.

3. From the Edit main menu, choose Specify URL
(Figure 7.2) or push Command-U on your
keyboard.

4. Type in the URL of the remote media in the
Specify Media URL dialog box (Figure 7.3). 
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Figure 7.2 Choose Specify URL
from the Sequence main menu.

Figure 7.1 Arrange the dummy media file
where you would like the remote movie to
play.

Figure 7.3 Enter the URL of the remote movie in the
Specify Media URL dialog box.



Sprites
One of the most powerful and professional features
of Looking Glass is its ability to use sprites. Sprites
are special graphical objects that can control related
movies, or link to a web site or e-mail address. In
other words, sprites give you a new way of
presenting your content. Sprites only work when a
project is rendered using the Make Movie feature.
Sprites can only be JPEG image files.

The Sprite Window

Sprites are embedded into sequences in a “sprite
track.” A sprite track can contain a specific
graphical image and can be told to do a number of
things.

The sprite window (Figure 7.4) is the control center
for a sprite. It’s in this window that you issue
commands and set specifics for a sprite track.
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Figure 7.4 The Sprite Window.



The Sprite Window has the following components:

• Name: allows you to change the name of your
sprite.

• On Click: lists a series of commands that can
be executed when the sprite in your movie is
clicked (Figure 7.5).

• Do Not Respond: Does nothing when
clicked.

• Goto Time: Goes to a certain time point in
the current movie.

• Pause: Pauses the current movie.

• Play: Tells QuickTime to play another
movie specified by you.

• Goto URL: Opens up the viewer’s web
browser to a specified URL.

• Goto Time: lets you specify the time point in
your movie you want to jump to if your choices
for On Click were Goto Time, Play, or Goto
Movie. If you check ‘Start Playing,’ the movie
will begin to play as soon as it loads.

• Goto URL allows you specify the web site you
want your viewers to visit if your choice for On
Click was Goto URL.

• Target Movie To Send Actions To let’s
you start playing another movie.

• On Mouse Over Change Mouse To lists
the choices available for the cursor when it
passes over the sprite in the viewer’s movie
Source Window (Figure 7.5).

• Do Not Change

• Open Hand

• Closed Hand

• Pointing Hand

• Right Arrow

• Left Arrow

• Down Arrow

• Up Arrow

• Custom… 
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Figure 7.4 On Click
choices.

Figure 7.4 On Mouse
Over choices.



• Mouse Exit File: is used when the mouse is
not over sprite’s image.

• Mouse Over File: is used when the mouse is
over sprite’s image. 

• Mouse Click File: is used when the mouse
click’s sprite’s image.

Sprites can perform five distinct actions. You decide
what the action will be using the ‘On Click’ area of
the sprite window. You can have multiple sprites per
project, and each sprite can do something different.

Sprites are only active when you render
out a project with Make Movie. They are
not active in Looking Glass, or if you
Export your project.

Creating Sprites

To create a sprite track:

1. Click on the Sequence Window to make it
active.

2. Under Sequence in the main menu, choose Add
Sprite Media (Figure 7.5).

3. A sprite track will be automatically added to
your project, and the Sprite Control window
will pop up. 

4. Specify the actions you want to attribute to the
sprite track and click OK.

Editing Sprites

To edit the sprite controls:

• Double-click on the sprite media bar in the
Sequence Window, or in the Project Window.
The control window will pop-up.

To edit the sprite’s duration:

• You can perform a QuickTrim on a sprite just
like on any other clip. Use this feature to adjust
the duration of the sprite. A sprite track has no
limit on how long it can be.

To edit the sprite’s position:

• Simply click the sprite in the Editor Window
and drag to the desired position. 

• A sprite’s position is keyframable. Follow the
animate directions in Chapter 6: Creating
Effects & Compositing.
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Figure 7.5 Choose Add Sprite Media
from the Sequence main menu.



Voice Over
One feature that is unique to Looking Glass is the
ability to voice over a sequence in real time. With a
microphone plugged into your computer, Looking
Glass allows you to play the sequence that you have
edited while you record your commentary. And it
doesn’t stop with just your voice. You can use any
input source for narration, be it your CD-ROM drive
or DV deck.

iMacs and newer Mac G4s come with a built in
mini-din microphone port. Connecting a microphone
this way gives you instant, no set-up access to an
external mic. But you can also use the mic on a DV
camera that is connected to your Mac via Firewire,
if you don’t have a stand-alone microphone.

Capturing a voice over

1. Make sure the Editor window is selected. Then,
choose ‘Voice over’ from the ‘Sequence’ menu.

2. A pop-up box will appear asking you to specify
the recording settings. The first three settings
you have to choose from are Source, Sample
and Compression.

•  The Compression option will allow you
to choose the form of compression, if any,
will be applied to the audio you are about
to record. 

•  The Sample option lets you specify the
quality of the sound sample you are about
to record. Select from mono, stereo, 22 or
44 kHz and other options.

•  The Source option allows you to choose
from where your audio will come.
Choosing ‘Built-In’ gives you the option to
choose to import via an external
microphone and other devices. Choosing
‘Internal CD’ lets you record audio directly
from a CD on your CD-ROM drive.
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Figure 7.6 Choose Voice Over from the
Sequence main menu.

Figure 7.7 Pick your settings.



Capturing from a microphone

1. Select ‘Source’ from the Sound pop-up box that
appears, and make sure the Device setting reads
‘Built-In’ then select ‘External Mic’ from the
Input section. Click OK (Figure 7.7 .

2. Next, when you confirm where to save your
file, the sequence will immediately begin
playing. Record your audio while the sequence
plays.

3. When the sequence reaches the end (or you
click to stop) your audio will automatically be
added to the Project window, ready to be used.

From A DV-Cam microphone

If you don’t have an external microphone, you
can use the mic on your camera, as long as your
camera is plugged into your computer through a
FireWire cable. Note: This only works on DV
cams through Firewire. It does not work
through USB Capture Devices.

1. In the Sound pop-up box, choose ‘Source’ from
the main pull down menu. 

2. Next, make sure ‘Device' is set to ‘DV Audio’
(Figure 7.8). Make sure your camera is
connected and turned on. 

3. Once you’ve chosen ‘DV Audio’ speak into the
mic on your camera. The levels will oscillate,
letting you know the mic is active.

4. Click OK. Once you confirm where to save
your file, the sequence will immediately begin
playing. Record your audio while the sequence
plays.

5. When the sequence reaches the end (or you
click to stop) your audio will automatically be
added to the Project Window, ready to be used.
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Figure 7.7 Pick your settings.

Figure 7.8 Choose DV-Audio from the Device menu.



Editing a voice over

After a narration has been completed, it’s added to
the Project Window. Editing a voice over is just like
editing any other video/audio track in Looking
Glass.

• Drag the narration clip from the Project Window
into the Editor Window. It will be given its own
track in the Timeline (Figure 7.9).

• Use the Split Clip feature to cut up the audio
and space it out of needed(Figure 7.10).

• Expand out the audio’s waveform, for more
precise Split Clip edits (Figure 7.11).

• Adjust the clip’s volume level, or keyframe
volume fades if desired (Figure 7.12).
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Figure 7.9 Dragging the Voice Over into the Editor
Window will give it its own track.

Figure 7.10 Use the Split Clip feature to splice up
the voice over to better fit with the pace of your
video.

Figure 7.11 Viewing the waveform can help make
precise edits.

Figure 7.12 Adjust the volume, and fade the voice
over in or out if desired.



Rendering

The ability to selectively render out the exact
media types you desire is a powerful Looking
Glass feature. This chapter will discuss the
following topics:

• Setting output length

• Using track based render settings

• Rendering just audio or video

Looking Glass provides you the ability to choose the compression schemes for each individual track,
and for each type of media. This chapter will walk you through using all of the many render
features available.
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Setting output length
Looking Glass allows you to set the output length of
a sequence using both the Make Movie and Export
commands. When it comes time to render out a
finished sequence to a movie file, you can choose to
render the entire sequence or just a piece of it.

To render an entire sequence

Rendering out an entire sequence is the default
setting for both Make Movie and Export. No special
settings need to be applied.

1. Click on the Sequence Window to make it
active.

2. Choose either Make Movie or Export from the
File main menu.

3. Choose where to save your file, set your
various options and click OK.

To render a section of a sequence

Make Movie and Export allow you to render out a
section of your sequence. 

1. Set In and Out points in the Sequence Window
to specify the section of the sequence you  want
to render out to a file (Figure 8.1).

2. Choose either Make Movie or Export from the
File main menu.

3. Choose where to save your file, set your
various options and click OK.

No other special procedures are necessary. 
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Figure 8.1 Notice that the sequence is
bigger than the In and Out points, but
only what is inside the In and Out
points will be rendered to a file.

The difference between Make Movie and Export
might be confusing. They are both used to turn your
Looking Glass sequence into a movie file, but they
each have their own specific uses. 

To find out more about each feature, as well as how
to use both Make Movie and Export to their fullest
potential see Chapter 9: Creating Final
Output. 

Make Movie vs. Export



Using track based
render settings

Setting render levels for each track

This feature only works with Make Movie.

1. Click the Track Render Settings button in the
Track Controls (Figure 8.2).

2. When the Track Compression Settings dialog
box appears, select the type of media you have
media that is present in that track by turning on
the check-boxes (Figure 8.3). Disable the media
types that are not present.

3. Click the Settings button to choose the
compression settings for each media type in the
track. 

4. If Video or Audio is present, but you don’t want
to change their format in any way, click the ‘Do
Not Change...’ check-box (Figure 8.4). This
options is not available for Graphics.

5. When you are done with specifying your
settings for each track choose Make Movie
from the File main menu.

6. After choosing a save location for your file,
choose Individual Track Settings from the
Compression Settings window and click OK
(Figure 8.5).
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Figure 8.2 Click the Track Render Settings
button to open the render settings options.

Figure 8.4 Clicking the ‘Do Not Change...’
check-box for Audio and Video means that
the media type will render out unchanged.

Figure 8.3 Click the check-boxes to activate
or deactivate that media type.

Figure 8.5 Choose Use Individual Track Settings
from the Compression Settings window.



To render a single track

This feature works with both Make Movie and
Export.

1. In the Timeline, click the Solo button in the
Track Controls on the track that you want to
render out by itself (Figure 8.6).

2. Choose Make Movie or Export from the File
main menu and follow the procedures to save
the track to a movie file.

Rendering just audio
or video
Both Make Movie and Export allows you to save
out just audio or video.

Export

1. Click on the Sequence Window to make it
active.

2. In the File main menu, select Export Movie,
then choose the Export... option (Figure 8.7).

3. When the Media Settings window appears,
make sure only the type of media you want to
export (video or audio) is checked(Figure 8.8). 
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Figure 8.6 Click Solo on the track that you
want to render out by itself.

Figure 8.7 Chose Export... from the Export drop
down list in the File main menu.

Figure 8.8 Make sure the type of media
you want to export is the only one
checked.



Make Movie

Globally

1. Click on the Sequence Window to make it
active.

2. In the File main menu, choose Make Movie.

3. In the Compression Settings dialog box, make
sure Use Default Settings is the active choice.
This will affect every  track in the sequence.

4. Make sure only the media type you want to
render is checked (Figure 8.10).

Track by track

1. Click on the Sequence Window to make it
active.

2. Click the Track Render Settings Button for each
track (Figure 8.11).

3. In the Track Compression Settings dialog box,
make sure only the media type you want to
render is checked (Figure 8.12). Click OK.

4. In the File main menu, choose Make Movie.

5. In the Compression Settings dialog box, make
sure Use Individual Track Settings is the active
choice (Figure 8.5).
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Figure 8.10 Make sure that Use Default Settings is
checked. Then check only the media type you want
to render. In this case, just audio and no video.

Figure 8.11 Click the Track Render Settings
button to open the render settings options.

Figure 8.12 Make sure only the media type
you want to render for that track is checked.
In this case, only the video of this track will
be rendered.



Creating Final
Output

When a project is finished it’s time to output it
for others to see. This chapter will cover:

• Poster frames

• Make Movie

• Export

• Creating Export Profiles

• Record to DV Tape

The most exciting part of finishing a project is being able to show it to people and clients! This
chapter will discuss the various options Looking Glass gives for exporting the movie you’ve made
out to a finished, viewable format.
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Poster frames
QuickTime has a built in feature for poster frames.
A poster frame is a frame from the movie file
selected to be the “icon” or “poster” for that file. In
other words, when that file is viewed in the
Macintosh Finder, or in QuickTime video cataloging
programs this file will appear as the icon. Poster
frames are per sequence, not per clip or per project.

To set a poster frame

1. Move the Scrubber in the Sequence Window to
the frame you want as the poster frame.

2. Choose Set Poster Frame from the Sequence
main menu (Figure 9.1).

To view the poster frame

1. Select GoTo poster frame from the Sequence
main menu (Figure 9.2).

The poster frame will be automatically embedded
into the movie file when you use the Export Movie
or Make Movie command.
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Figure 9.1 Choose Set Poster Frame
from the Sequence main menu.

Figure 9.2 Choose GoTo Poster Frame
to view the set poster frame.



Make Movie
Make Movie renders out multiple track QuickTime
movies. It allows you to render each track with
different render settings. Make Movie also allows
you to apply different compression to video, audio
and graphics in the same sequence. It has several
functions, one of which is keeping your titles crisp
and clear (see Appendix A: Working With
DV).

QuickTime Real Time Effects

Whenever a transition or other effect is applied to a
movie in Looking Glass, it is handled in real time.
The effect is not burned into the movie file yet, so
your Mac has to process all the frames on the fly.
When a movie is rendered with Make Movie, the
transitions are not burned in, as they are when using
the Export feature. When a movie rendered using
Make Movie is viewed in the QuickTime player, it
may seem choppy. This is because there are skipped
frames, because QuickTime cannot handle the
throughput.

Track Render Settings

Using the Track Render Settings icon in the
Sequence Window allows you to specify different
compression settings for each track in a sequence. 

When you choose Make Movie and are taken to the
Compression Settings dialog box, you are given the
choice of using the individual track settings, or
default settings
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Global Compression Settings

After you choose Make Movie and specify where to
save your file, the Compression Settings dialog box
will appear. Selecting ‘Use Default Settings’ will
allow you to specify compression settings for all
video, audio and graphics in your project.

When is Make Movie useful?

Make Movie can be used on its own to quickly
render out a sequence for preview, but its not
recommended for final output due to the fact that it
does not burn on transitions, and multi-track movies
can be more troublesome to view.

Make Movie’s strength comes in when it is used in
conjunction with the Export feature. 

With Sprites

Sprites only work when you render out a
sequence with Make Movie. But what if you
need sprites in your project, but you also have
transitions that need to be burned in? That’s
when using Make Movie along with Export
becomes handy.

With titles and graphics

If there is a graphic in a sequence it will be
compressed using the Export command.
Compressing a graphic, especially a title, can
blur the image badly. The best case scenario
would be to have a finished movie with
compressed video, but an uncompressed title or
graphic. Using Make Movie along with the
Export command can do just this.

Chapter 8: Rendering has more detailed
information about setting track render settings and
global compressions settings. It walks you through
how to set individual track render settings, how to
choose between individual track and global
compression settings, among other things.

I Need to Know More



Using Make Movie with Sprites

Chapter 7: Multimedia discusses the purpose
of Sprites as well as how to use them. Sprites only
work when a sequence is rendered out with Make
Movie. So, if you have a sequence that uses
transitions but you still need sprites in your finished
product, what is the solution? The solution is to use
Make Movie and Export together.

Using Make Movie and Export with
sprites

1. Finish editing the sequence in the Sequence
Window. Do not add any sprite tracks yet.

2. Use Export from the File main menu and save
your sequence to a QuickTime movie file on
your computer. Compress the video and audio
using the codec you desire for final viewing.

3. Click on the Project Window to make it active
and from the Sequence main menu, select New
(Figure 9.3).

4. Double click on the new sequence in the
Project Window to open it up.

5. Drag the movie you just exported from the
Project Window into the new sequence.

6. Now, create your sprite tracks by choosing Add
Sprite Media from the Sequence main menu
(Figure 9.4).

(continued)
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Figure 9.3 Choose to make a new
sequence from the File main menu.

Figure 9.4 Choose Add Sprite media from
the Sequence main menu.



7. Adjust sprite tracks how you need in the
Timeline (Figure 9.5).

8. When you’re finished choose Make Movie from
the File main menu (Figure 9.6).

9. Choose a save location for the file.

10. When the Compression Settings dialog box
appears choose Use Default Settings. Make sure
both the Video and Sound boxes are checked
(Figure 9.7).

Your project will now be rendered out with the
sprites intact. Since you rendered the main portion
of your movie containing transitions and effects
using Export, your project will play smoothly in
QuickTime.
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Figure 9.6 Choose Make Movie
from the File main menu.

Figure 9.7 Choose ‘Use Default Settings’ and make
sure that both Video and Sound are checked.

Figure 9.5 Add the exported movie to the new
sequence, then create how ever many sprite tracks
you need above it.



Using Make Movie with titles

Chapter 6: Creating Effects and
Compositing discusses the basics of making
titles for your movie that will work in Looking
Glass. When making a movie for play on a
computer video compression can often make titles
appear blurry and sometimes unreadable. So, if you
have a sequence that uses transitions but you still
need a title in your finished product, what is the
solution? The solution is to use Make Movie and
Export together.

Using Make Movie and Export with
titles

1. Finish editing the sequence in the Sequence
Window. Do not add any title graphic images
yet. 

2. Use Export from the File main menu and save
your sequence to a QuickTime movie file on
your computer. Compress the video and audio
using the codec you desire for final viewing.

3. Click on the Project Window to make it active
and from the Sequence main menu, select New
(Figure 9.8).

4. Double click on the new sequence in the
Project Window to open it up.

5. Drag the movie you just exported from the
Project Window into the new sequence.

6. Adjust the titles and exported movie as
necessary in the timeline (Figure 9.9).

(continued)
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Figure 9.8 Choose to make a new
sequence from the Sequence main menu.

Figure 9.9 Arrange the title graphic file as necessary
over the exported movie.



7. When you’re finished choose Make Movie from
the File main menu (Figure 9.10).

8. Choose a save location for the file.

9. When the Compression Settings dialog box
appears choose Use Default Settings. Make sure
both the Video and Sound boxes are checked
(Figure 9.11).
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Figure 9.10 Choose Make Movie
from the File main menu.

Figure 9.11 Choose ‘Use Default Settings’ and make
sure that both Video and Sound are checked.



Export
When you’re done editing your project you can
export it out to a movie to be shared via the Internet,
CD-ROM, or just to store on your computer. The
Export feature compresses every track  in your
project to a one video and one audio track,
flattening down your project to a QuickTime movie.

Supported formats

Listed below are the export formats that QuickTime
5 supports. We recommend choosing ‘Movie to
QuickTime Movie.’

• Movie to AVI

• Movie to BMP

• Movie to DV Stream

• Movie to FLC

• Movie to Hinted Movie

• Movie to Image Sequence

• Movie to Picture

• Movie to QuickTime Movie

• Movie to AIFF

• Movie to System 7 Sound

• Movie to Wave

• Movie to uLaw

Exporting defaults

Looking Glass comes with six default export
settings. These can be accessed by choosing Export
from the File main menu (Figure 9.12).

These settings are:

• DV - NTSC 32 kHz

• DV - NTSC 48 kHz

• Internet Music 56k

• Internet Music Broadband

• Internet Voice 56k

• Internet Voice Broadband
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Figure 9.12 There are six default export settings.



DV - NTSC 32 kHz

This output is made for exporting full size, full
quality DV content onto a tape. It is not intended to
be streamed on the internet. Designed for the North
American NTSC video standard.

DV - NTSC 48 kHz

This output is made for exporting full size, full
quality DV content onto a tape. It is not intended to
be streamed on the internet. Designed for the North
American NTSC video standard. This choice offers
a much higher sampling rate for audio, but also
creates a bigger file.

Internet Music 56K

This scheme allows users with dial-up connections
the ability to view your project. It’s made to have
good audio response to a wide frequency of sounds.
This is the best choice for any project where that has
more sounds involved than simply the human voice.
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Internet Music Broadband

This scheme is designed to have good audio
response to a wide frequency of sounds. It’s ideal
for creating a movie that is small enough to be
viewed easily by people with a broadband
connection. This is the best choice for any project
where that has more sounds involved than simply
the human voice.

Internet Voice 56K

This scheme allows users with dial-up connections
the ability to view your project. It’s made to reduce
the amount of data size the audio track will take up,
while still delivering crisp clear sound. This is the
best choice for any project where the human voice is
the primary sound source, like a news cast.

Video:

NTSC- DV

Best Quality

29.97 FPS

Sound:

32 kHz sampling

16 bit stereo

Streaming:

Fast Start

Video:

NTSC- DV

Best Quality

29.97 FPS

Sound:

48 kHz sampling

16 bit stereo

Streaming:

Fast Start

Video:

Sorenson Video 3

Best Quality

4 FPS

Keyframes every 400

4 Kbytes/s data limit

160 x 120

Sound:

Qdesign Music 2

22 kHz sampling

16 bit stereo

20 kbits/s data rate

Streaming:

Fast Start

Video:

Sorenson Video 3

Best Quality

15 FPS

Keyframe every 1500

150 Kbytes/s

320 x 240

Sound:

Qdesign Music 2

44.1 kHz sampling

16 bit stereo

40 kbits/s data rate

Streaming:

Fast Start

Video:

Sorenson Video 3

Best Quality

4 FPS

Keyframe every 400 

4 Kbytes/s data limit

160 x 120

Sound:

Qualcomm Purevoice

44.1 kHz sampling

16 bit stereo

Half rate

Streaming:

Fast Start



Internet Voice Broadband

This scheme is designed to reduce the amount of
data size the audio track will take up, while still
delivering crisp clear sound. It’s ideal for creating a
movie that is small enough to be viewed easily by
people with a broadband connection. This is the best
choice for any project where the human voice is the
primary sound source, like a news cast.

Custom export

‘Export…’ from the Export Movie selection from
the File main menu (Figure 9.13), is the custom
export option. It allows you to specify the
compressions settings for your movie.

To adjust the export options for a movie

1. Select Export... under Export Movie from the
File main menu (Figure 9.13).

2. Click Options to open the Movie Settings
Window(Figure 9.14).
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Video:

Sorenson Video 3

Best Quality

15 FPS

Keyframe every 1500

150 Kbytes/st

320 x 240

Sound:

Qualcomm Purevoice

44.1 kHz sampling

16 bit stereo

Full data rate

Streaming:

Fast Start

Figure 9.13 Export... is the custom export option.

Figure 9.14 Choose Options to open the Movie
Settings Window.



Movie Settings Window

The Movie Settings Window (Figure 9.15) has three
major categories: Video, Sound, and Prepare For
Internet Streaming.

Video

The video section allows you to choose the
Settings, Filter and Size for your movie. As
long as the box by VIDEO is checked, then
video will be saved in your final file. 

Uncheck this box if you do not desire your
video tracks to be rendered. The area to the
right displays the current video settings, and
will update depending on the changes you
make.

When you click the ‘Settings…’ button, you’ll
be presented with a dialog box called
‘Compression Settings’ asking you to specify
the compressor and other specifics for your
video. 

Use the Quality controls to finish making
adjustments to the compression settings of your
video. Click ‘OK’ or ‘Cancel’ when you’re done
to return to the ‘Movie Settings’ dialog box.

Clicking on ‘Filter…’ open the ‘Choose Video
Filter’ dialog box. These filters alter the color,
hue, brightness, or other aspects of the video in
your project. You can apply only one filter to
your movie. The filter dialog box allows you to
save a filter setting. Depending on which filter
you choose, you’ll be presented with controls.
After adjusting these controls, you can click
‘Save’ and save these settings in a file. To
obtain these settings later, click the ‘Load’
button. 

Clicking ‘Size…’ in the ‘Movie Settings’ dialog
box gives you the option to adjust the size of
your exported movie. If you check ‘Use Current
Size,’ the movie will be exported at the same
size as the sequence.

If you check ‘Use Custom Size’ you specify the
Width and Height in pixels.
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Figure 9.15 The Movie Settings Window.



Sound

Clicking the Settings button in the Sound
portion of the Movie Settings Window opens up
the audio compression options. 

After selecting the compressor you want,
specify the audio’s quality by choosing the
sampling rate, bit size, and number of channels.

Prepare for Internet Streaming

This option, by default, is set for Fast Start.
Make sure it is checked, as this option loads the
movie faster in QuickTime and is
recommended.

Creating Export
Profiles
Looking Glass comes with six pre-defined export
settings, but it also lets you make your own. Once
saved these settings will appear in the Export Movie
sub-menu under the main File menu.

To create an export profile:

1. Choose Create Export Profile under the File
main menu (Figure 9.16).

2. Input the selection you desire for Video, Sound
and Internet Streaming in the Movie Settings
dialog box (Figure 9.17). 

3. When you are finished click the ‘OK’ button in
the Movie Settings window.

4. You will be asked to name and your file, and
then save it.

5. All export settings files will be kept in the
Export Settings folder in the Looking Glass
folder.

It is possible to share your export setting files. To
use a file from someone else:

1. Quit Looking Glass and place a Looking Glass
export setting file in the Export Settings folder
in the Looking Glass folder.

2. Open Looking Glass, and the new file will
appear in the Export Movie menu.
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Figure 9.16 Choose Create
Export Profile in the File menu too
make export settings.

Figure 9.17 Adjust the settings in the Movie
Settings dialog box.



Render Preview
Use the render preview settings before exporting for
the web or recording to DV tape to see how it will
look.

To set a Render Preview folder

When you use the Render Preview function,
Looking Glass places the preview file in a folder on
your computer. Before using the Render Preview
function you need to set a folder.

1. In the File main menu, choose Set Preview
Folder (Figure 9.18).

2. Choose a folder on your computer to use as the
Render Preview folder and click choose. 

To use Render Preview

1. Click on the Editor or Sequence window to
make one of them the active window.

2. Select Render Preview from the Sequence main
menu (Figure 9.19).

3. You can choose one of the predefined settings
in the drop down menu that appears, or you can
Other... to specify your own.

4. Looking Glass will build a preview (this might
take a long time) and insert the file into your
current sequence.

5. Simply place the sequence to view how your
finished movie will look.

6. Delete the track holding the render preview to
continue editing.

You can also set In and Out points in your sequence
and Render Preview will render out only the video
that is within those points.
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Figure 9.18 Choose Set Preview Folder
in the File main menu to select a folder
for the Render Preview files to go to.

Figure 9.19 Choose Render Preview from the
Sequence main menu, then decide on the settings.



Record To DV t ape
Once you’re finished with your project, Looking
Glass allows you to export to DV tape. You can only
export to a DV camera or deck via FireWire.
Exporting over a USB Capture Device or any other
method is not supported.

There are multiple region DV codes. North America
uses NTSC. Most of Europe uses PAL, and France
uses SECAM. All equipment within a region is
designed to work with that regions code. For this
reason, if you’re in North America make
sure you export only in DV - NTSC.

Aspect ratio and issues

DV uses rectangular shaped pixels. Computer
screens use square pixels. To make up for this
difference, when a DV image is imported to a
computer, its size is changed. When it’s sent back to
DV tape, the picture is reverted back to its original
DV state.

When brought in on a computer, DV has a size of
720 x 480. For this reason DV on a computer might
look vertically disproportionate. Figures 9.20 and
9.21 illustrate this.

To learn how to preview video in Looking Glass in
actual DV size, see the titling section of Chapter
6: Creating Effects & Compositing.
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Unadjusted computer DV Adjusted with View DV feature

Figure 9.20 DV video displayed on a
computer is compressed vertically.

Figure 9.21 DV video adjusted with the View
DV feature as it would appear on a TV.



Titles and graphics

Understanding how DV size works becomes
truly important when there is a title or graphic
in your project. If the title in your project based
on a 720 x 480 size, it will be distorted and
“stretched out” when recorded to DV tape.
That’s because, even though 720 x 480 is DV
size on a computer, things are vertically
disproportionate on purpose. In pixels, the
closest approximation a computer can make to
true DV size is use 720 x 540.

There is a solution to this problem. The solution
is to make titles or graphics on a canvas size of
720 x 540, then change the size of the image to
720 x 480. This will make your title looked
squashed, but when exported to DV tape, it will
stretch out to its normal proportions.

Building DV content

Record to DV with all DV content

1. Make sure your camera or deck is connected to
your computer via FireWire and that it is turned
on.

2. Under ‘File’ in the main menu, choose ‘Record
to DV’ (Figure 9.22)

3. A dialog box will appear (Figure 9.23), telling
you to begin recording from your DV device.
Once the tape in your camera or deck is
recording click ‘Record’ in the dialog box. 
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Figure 9.22 Choose ‘Record To DV’
from the File main menu.

Figure 9.23 Click Record to print your sequence to
DV tape.



If some content in your sequence is non-DV,
including graphic or sound files, then you will need
to Export your sequence as a DV file before it can
be transferred to tape.

Record to DV tape with non-DV
content

1. Make sure your camera or deck is connected to
your computer via FireWire and that it is turned
on.

2. Under ‘File’ in the main menu, choose ‘Record
to DV’ (Figure 9.24).

3. Looking Glass will present you with a notice
message warning that converting your sequence
to DV might take some time. Click OK to
continue. (Figure 9.25).

4. When Looking Glass is done rendering your
sequence to DV format, it will ask you if it is
ok to begin recording to DV tap (Figure 9.26).
Click RECORD to continue.
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Figure 9.24 Choose DV - NTSC 48kHz from the
Export Movie drop down menu.

Figure 9.25 Looking Glass will present this
notification message before converting your
sequence to DV.

Figure 9.26 Click Record to print your sequence to
DV tape.



Working With
DV

DV frame size
DV has a different aspect ratio on a TV screen than on a computer screen. DV uses rectangular shaped
pixels, while computer screens use square pixels. To make up for this difference, when a DV image is
imported to a computer its size is changed. When a DV image is sent back to DV tape its original size is
restored.

When DV is brought into a computer it has a size of 720 x 480, as shown in Figure A.1. In reality, a closer
approximation to a DV images actually shape is the aspect ratio of 720 x 520 as shown in Figure A.2.
Looking Glass allows you to preview any video you are editing in its natural DV state. See Chapter 6:
Creating Effects & Compositing for an in depth walk through on how to use this feature.
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A

Unadjusted computer DV size Adjusted with View DV feature

Figure A.1 720 x 480, computer DV size. Figure A.2 720 x 520, TV DV size.



Graphics
Understanding how DV size works becomes truly important when there is a title. If the title in your project based
on a 720 x 480 size, it will be distorted and “stretched out” when recorded to DV tape. That’s because, even
though 720 x 480 is DV size on a computer, things are vertically compressed on purpose. In pixels, the closest
approximation a computer can make to true DV size is use 720 x 540.

There is a solution to this problem. The solution is to make titles or graphics on a canvas size of 720 x 540, then
change the size of the image to 720 x 480. This will make your title looked compressed, but when exported to DV
tape, it will stretch out to its normal proportions.

When Exporting a movie with a text title, the title will become muddy due to compression. Sometimes, it’s best to
Export your finished movie without that title, bring the exported movie back into Looking Glass, lay the title
graphic where you want it, and choose Make Movie with no compression for graphic files. This will ensure the
title has a clean appearance. See Chapter 9: Creating Final Output for a detailed walk through on how to
use Export Movie and Make Movie together to keep titles and graphics crisp.

Non-drop frame mode
The standard spec for DV is 29.97 frames per second (FPS). This is called drop-frame mode. Normal timecode
reads an exact 30 FPS and drop-frame timecode compensates by dropping two frames at every minute except the
tenth.

The timeline in Looking Glass works in non-drop frame mode only. Looking Glass shows DV at a constant 30
FPS. This will have an effect on long project, resulting in a loss of roughly 18 frames for every 10 minutes. Your
video will play back correctly, without obvious skips or stutters. Because of this the Sequence Window can only
show FPS rates that are whole numbers. 
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Menus

This Appendix walks through all the main
menus in Looking Glass, with a description of
each function.
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•  Figure B.1 shows the File menu.
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New

Open

Import Media

Find Files

Reveal In Finder

Close

Save

Save As

Make Movie....

Export Movie

Capture...

Record Audio To Disk...

Record To DV...

Command
Creates a new Project, Sequence or Track.

Opens a Looking Glass Project.

Imports a QuickTime compatible media file.

Finds media files on your computer.

Shows where on your computer a file is located.

Closes the Project currently open.

Saves the current project under the same file name.

Allows you to save the current project under a new name.

Renders out a multi-track QuickTime movie.

Exports a compressed QuickTime movie.

Captures video from an outside source.

Allows you to record audio to your computer.

Prints the current DV project back to DV tape.

Description

Figure B.1 The File menu.



•  Figure B.2 shows the Edit menu with the Media
Controls sub-menu dropped down.
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Undo...

Redo

Cut

Copy

Paste

Clear

Select All

Duplicate

Media Controls

Goto

In/Out Point Control

Insert Clip

Zoom Window

Freeze Frame

View DV Size

Command
Undoes the last action.

Reinstates the last undo.

Cuts text to the clipboard.

Copies text to the clipboard.

Pastes the text in the clipboard.

Clears the currently selected text.

Selects all items in the active window.

Moves a track forward or backward in a sequence.

Control the video in the Editor, Source and Sequence windows .

Jump to the beginning or end of a sequence.

Sets, deleted and jumps to an in or out point.

Performs a basic 3-point edit from the Source to Sequence window.

Zooms in and out of the Edit and Sequence windows.

Exports a frame as a still image.

Previews the sequence in the Edit window in full DV size.

Description

Figure B.2 The Edit menu.



•  Figure B.3 shows the Edit menu with the Goto
and Zoom Window sub-menus dropped down.
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Undo...

Redo

Cut

Copy

Paste

Clear

Select All

Duplicate

Media Controls

Goto

In/Out Point Control

Insert Clip

Zoom Window

Freeze Frame

View DV Size

Command
Undoes the last action.

Reinstates the last undo.

Cuts text to the clipboard.

Copies text to the clipboard.

Pastes the text in the clipboard.

Clears the currently selected text.

Selects all items in the active window.

Moves a track forward or backward in a sequence.

Control the video in the Editor, Source and Sequence windows .

Jump to the beginning or end of a sequence.

Sets, deleted and jumps to an in or out point.

Performs a basic 3-point edit from the Source to Sequence window.

Zooms in and out of the Edit and Sequence windows.

Exports a frame as a still image.

Previews the sequence in the Edit window in full DV size.

Description

Figure B.3 The Edit menu.



•  Figure B.4 shows the Edit menu with the In/Out
Point Control sub-menu dropped down.
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Undo...

Redo

Cut

Copy

Paste

Clear

Select All

Duplicate

Media Controls

Goto

In/Out Point Control

Insert Clip

Zoom Window

Freeze Frame

View DV Size

Command
Undoes the last action.

Reinstates the last undo.

Cuts text to the clipboard.

Copies text to the clipboard.

Pastes the text in the clipboard.

Clears the currently selected text.

Selects all items in the active window.

Moves a track forward or backward in a sequence.

Control the video in the Editor, Source and Sequence windows .

Jump to the beginning or end of a sequence.

Sets, deleted and jumps to an in or out point.

Performs a basic 3-point edit from the Source to Sequence window.

Zooms in and out of the Edit and Sequence windows.

Exports a frame as a still image.

Previews the sequence in the Edit window in full DV size.

Description

Figure B.4 The Edit menu.



•  Figure B.5 shows the Edit menu with the In/Out
Point Control sub-menu dropped down.
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Figure B.5 The Edit menu.

Undo...

Redo

Cut

Copy

Paste

Clear

Select All

Duplicate

Media Controls

Goto

In/Out Point Control

Insert Clip

Zoom Window

Freeze Frame

View DV Size

Command
Undoes the last action.

Reinstates the last undo.

Cuts text to the clipboard.

Copies text to the clipboard.

Pastes the text in the clipboard.

Clears the currently selected text.

Selects all items in the active window.

Moves a track forward or backward in a sequence.

Control the video in the Editor, Source and Sequence windows .

Jump to the beginning or end of a sequence.

Sets, deleted and jumps to an in or out point.

Performs a basic 3-point edit from the Source to Sequence window.

Zooms in and out of the Edit and Sequence windows.

Exports a frame as a still image.

Previews the sequence in the Edit window in full DV size.

Description
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Figure B.6 The Sequence menu.

New...

Settings...

Sequence Scrolls With Timeline

Hide/Show Shy Tracks

Track

Track View Options

Track Control Buttons

Add Time to Beginning...

Remove Black

Split Clip

Add Sprite Media

Add Voice Over...

Annotate...

Set Poster Frame

Goto Poster Frame

Render Preview

Command
Creates a new sequence.

Changes the sequence settings.

When checked, sequence will scroll with timeline while playing. 

Hides/Shows tracks that have been marked to be shy.

Adds a new track or re-arranges their order in the Sequence Window.

Changes how tracks are presented in the Sequence Window.

Provides the functionality of the control buttons in each track from the menu.

Adds blank time to the start of a sequence.

Removes blank space inside a track.

Cuts a clip at the scrubber’s location.

Inserts a Sprite Track into the current sequence.

Allows you to record narration for the current project.

Opens up the Annotation Add/Edit dialog box.

Sets the frame to be seen as the icon of the exported movie file.

Goes to the set poster frame.

Allows you to see a sequence as it would look rendered to a file.

Description

•  Figure B.6 shows
the Sequence
menu with the
Track and Render
Preview sub-
menus dropped
down.



•  Figure B.7 shows the Sequence menu with the
Remove Black sub-menu dropped down.
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Figure B.7 The Sequence menu.

New...

Settings...

Sequence Scrolls With Timeline

Hide/Show Shy Tracks

Track

Track View Options

Track Control Buttons

Add Time to Beginning...

Remove Black

Split Clip

Add Sprite Media

Add Voice Over...

Annotate...

Set Poster Frame

Goto Poster Frame

Render Preview

Command
Creates a new sequence.

Changes the sequence settings.

When checked, sequence will scroll with timeline while playing. 

Hides/Shows tracks that have been marked to be shy.

Adds a new track or re-arranges their order in the Sequence Window.

Changes how tracks are presented in the Sequence Window.

Provides the functionality of the control buttons in each track from the menu.

Adds blank time to the start of a sequence.

Removes blank space inside a track.

Cuts a clip at the scrubber’s location.

Inserts a Sprite Track into the current sequence.

Allows you to record narration for the current project.

Opens up the Annotation Add/Edit dialog box.

Sets the frame to be seen as the icon of the exported movie file.

Goes to the set poster frame.

Allows you to see a sequence as it would look rendered to a file.

Description



•  Figure B.8 shows the Sequence menu with the
Track View Options sub-menu dropped down.
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Figure B.8 The Sequence menu.

New...

Settings...

Sequence Scrolls With Timeline

Hide/Show Shy Tracks

Track

Track View Options

Track Control Buttons

Add Time to Beginning...

Remove Black

Split Clip

Add Sprite Media

Add Voice Over...

Annotate...

Set Poster Frame

Goto Poster Frame

Render Preview

Command
Creates a new sequence.

Changes the sequence settings.

When checked, sequence will scroll with timeline while playing.

Hides/Shows tracks that have been marked to be shy.

Adds a new track or re-arranges their order in the Sequence Window.

Changes how tracks are presented in the Sequence Window.

Provides the functionality of the control buttons in each track from the menu.

Adds blank time to the start of a sequence.

Removes blank space inside a track.

Cuts a clip at the scrubber’s location.

Inserts a Sprite Track into the current sequence.

Allows you to record narration for the current project.

Opens up the Annotation Add/Edit dialog box.

Sets the frame to be seen as the icon of the exported movie file.

Goes to the set poster frame.

Allows you to see a sequence as it would look rendered to a file.

Description



•  Figure B.9 shows the Sequence menu with the
Track Controls Buttons sub-menu dropped
down.
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Figure B.9 The Sequence menu.

New...

Settings...

Sequence Scrolls With Timeline

Hide/Show Shy Tracks

Track

Track View Options

Track Control Buttons

Add Time to Beginning...

Remove Black

Split Clip

Add Sprite Media

Add Voice Over...

Annotate...

Set Poster Frame

Goto Poster Frame

Render Preview

Command
Creates a new sequence.

Changes the sequence settings.

When checked, sequence will scroll with timeline while playing. 

Hides/Shows tracks that have been marked to be shy.

Adds a new track or re-arranges their order in the Sequence Window.

Changes how tracks are presented in the Sequence Window.

Provides the functionality of the control buttons in each track from the menu.

Adds blank time to the start of a sequence.

Removes blank space inside a track.

Cuts a clip at the scrubber’s location.

Inserts a Sprite Track into the current sequence.

Allows you to record narration for the current project.

Opens up the Annotation Add/Edit dialog box.

Sets the frame to be seen as the icon of the exported movie file.

Goes to the set poster frame.

Allows you to see a sequence as it would look rendered to a file.

Description



• Figure B.10 shows the Windows menu and

• Figure B.11 shows the Help menu.
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Assets Window

Info Window

Transition Window

Windows

Command
Opens the Assets Window.

Opens the Information Window for media.

Opens the Transition Window.

Brings the selected window to the front.

Description

Looking Glass Help

Looking Glass Home Page

Info on Production Version

Command
Opens the Help topics.

Opens the Looking Glass home page in your web browser.

Gives information about the professional edition of Looking Glass.

Description

Figure B.10 The Windows menu.

Figure B.11 The Help menu.



Keyboard
Shortcuts
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Timeline Shortcuts

• Q = Jump to In Point

• W = Jump to Out Point

• E = Set In Point

• I = Set In Point

• R = Set Out Point

• O = Set Out Point

• T = Set In/Out points based on highlighted clip

• D = Clear In Point

• F = Clear Out Point

• G = Clear I/O Points

• B = Insert clip from Source window to timeline.

• A = Go to start of sequence

• S = Go to end of sequence

• V = Toggle Insert/Overlay mode

• K = Pause

• L = Play

• ~ = Play

• 1 = Step back 10 frames

• 2 = Step forward 10 frames

• 3 = Previous frame

• 4 = Next frame

• 5 = Play

• 6 = Play till Out Point

• + = Step zoom in

• -  = Step zoom out

• SHFT + = Max zoom in

• SHFT - = Max zoom out

• 0 = Return to 100% zoom

• Home = Start of sequence

• End = End of selected sequence

• U = Open bar view for selected track

• SHFT U = Close bar view for selected track

• SHFT OPT U =  Collapse selected track

General Shortcuts

• -A = Select All

• -D = Duplicate

• -E = Split Clip

• -F = Find Files

• -I = Information Window

• -J = New Sequence

• -K = New Track

• -M = Make Movie

• -N = New Project

• -O = Open Project

• -Q = Quit Looking Glass

• -R = Redo

• -S = Save As

• -T = Transition Window

• -U = Specify URL

• -W = Close

• -Z = Undo

• - / = View DV Size
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• - B = Delete

• - P = Record To DV

• - Y = Redo

• OPT N = Sequence Settings...

• OPT S = Save As

• OPT C = Capture...

•  [ = Move a track up one

•  ] = Move a track down one 

•  SHFT [ = Move a track to the top

•  SHFT ] = Move a track to the bottom



• Option +                   = Movie snaps to 100%

Using this shortcut automatically sizes the
movie in the Editor Window to 100%.

• Option + Source Window = Put in sequence

Clicking anywhere in the Source Window while
holding down Option inserts the clip in the
Source Window into the current sequence.

• Option + + Click between Scrubber & clip’s
end = Go to last frame

Clicking between the end of a clip and the
scrubber, while holding down the buttons listed,
will automatically move the scrubber to the last
frame of that clip
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Buttons

Editor Window

Transport Controls

Previous Mark

Go To In Point

Previous Frame

Play

Next Frame

Go To Out Point

Next Mark

Set In Point

Remove In Point

Remove In and Out Points

Remove Out Point

Set Out Point

Set/Clear Mark
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D

Button
Moves the Scrubber to the previous mark.

Moves the Scrubber to the set In Point.

Moves the Scrubber to the previous frame.

Plays the Sequence from the Scrubbers position.

Moves the Scrubber to the next frame.

Moves the Scrubber to the set Out Point.

Moves the Scrubber to the next mark.

Sets an In Point at the Scrubber’s location.

Deletes the In Point.

Removes the In & Out Points in a sequence.

Deletes the Out Point.

Sets an Out Point at the Scrubber’s location.

Adds or deletes a mark at the Scrubber’s current location.

Description



Tool Palette

Sequence Window

Transport Controls
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Arrow Tool

Rotate Tool

Flip Tool

Zoom Tool

Button
Reposition media in the Editor Window.

Rotates media in the Editor Window.

Flips media horizontally in the Editor Window.

Zoom In/Out on Editor Window content.

Description

Previous Mark

Go To In Point

Previous Frame

Play

Next Frame

Go To Out Point

Next Mark

Set In Point

Remove In Point

Remove In and Out Points

Remove Out Point

Set Out Point

Set/Clear Mark

Button
Moves the Scrubber to the previous mark.

Moves the Scrubber to the set In Point.

Moves the Scrubber to the previous frame.

Plays the Sequence from the Scrubbers position.

Moves the Scrubber to the next frame.

Moves the Scrubber to the set Out Point.

Moves the Scrubber to the next mark.

Sets an In Point at the Scrubber’s location.

Deletes the In Point.

Removes the In & Out Points in a sequence.

Deletes the Out Point.

Sets an Out Point at the Scrubber’s location.

Adds or deletes a mark at the Scrubber’s current location.

Description



Track Buttons
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Button Description

Cycles through frames preview in the Timeline.

Cycles between overlay and insert modes.

Sets render options per track for Make Movie.

Turns a track off in the Editor & Sequence Windows.

Lock makes a track unchangeable.

Solo mutes all tracks but the one selected.

Frames

Overlay/Insert

Render Settings

Mute

Lock

Solo

Shy Shy hides track from the Timeline.



Connecting
Capture
Devices

This appendix covers general issues regarding
connecting a camera or deck to your
computer via FireWire or a USB capture
device, as well as a comprehensive
breakdown of the options QuickTime gives
when capturing video and audio.

For more information regarding using the Looking Glass software to capture media, see Chapter 3:
Bringing Media Into Projects.
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DV
FireWire is used to transfer digital video from DV
cameras. The FireWire cable plugs into a special
FireWire port on your camera and into the back of
your Macintosh. Most Macintosh computers
produced since the iMac in 1998 come with a
FireWire port.

FireWire is not only fast, but transfers both video
and audio. On some cameras FireWire is referred to
as iLink or DV In/Out. 

• Figure E.1 shows what a FireWire cable looks
like.

• Figure E.2 shows where the FireWire ports are
on the back of a PowerMac G4 tower.

Connecting

1. To connect your DV camera or deck to your
computer first plug the FireWire cable into the
back of your computer (Figure E.3).

2. Next, plug the other end of the FireWire cable
into your camera or deck (Figure E.4).
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Figure E.1 A FireWire Cable.

Figure E.2 The FireWire ports
on a PowerMac G4 tower.

Figure E.3 Plug the FireWire
cable into your computer.

Figure E.4 Then, plug the
FireWire cable into your
camera.



USB
USB (Universal Serial Bus) is used for connections
of all types. It can be used to connect printers,
keyboards, digital still camera, microphones, and
even a video camera to a computer. To capture video
on a computer through a USB port you will need a
USB Capture Device. 

• Figure E.5 shows what a typical USB capture
device looks like.

• Figure E.6 shows where the USB ports are on
the back of a PowerMac G4 tower. 

USB Capture Devices only capture video at
320x240 resolution. 

USB Capture Devices connect to cameras through
RCA and S-Video cables. Most modern cameras
have both RCA and S-Video ports built in. 

RCA cables (Figure E.7) have three plugs: yellow,
white and red. The red and white plugs carry the left
and right channels of a stereo audio signal. The
yellow RCA plug carries the video signal.

S-Video (Figure E.8) carries video only. The S-
Video signal is higher quality than the signal for
RCA video. We recommend using the RCA red and
white plugs for audio, and the S-Video plug for
video. The yellow(video) RCA plug will not be
necessary.
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Figure E.5 A USB capture
device.

Figure E.6 USB ports on a
PowerMac G4.

Figure E.7 RCA plugs.

Figure E.7 S-Video cable.



Modern cameras come with both S-Video and RCA
ports. Figure E.8 illustrates where these ports
typically are. Keep in mind that all cameras are
different.

Connecting

1. Plug the USB capture device into a USB port
on the back of your computer (Figure E.9).

2. Plug the RCA cables you will be using into the
USB capture device (Figure E.10). 

(continued)
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Figure E.8 RCA and S-Video
ports on a video camera.

Figure E.9 Plug the USB capture
device into your computer.

Figure E.10 Plug the RCA
cables you will be using into the
USB capture device.



Connecting (cont.)

3. If you will be using the S-Video cable, then
plug it into the USB capture device. (Figure
E.11).

4. Plug the RCA cables you will be using into the
camera (Figure E.12).

5. Lastly, plug the S-Video cable into the camera.
(Figure E.13).
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Figure E.11 RCA and S-Video
ports on a video camera.

Figure E.12 Plug the RCA
cables into your camera.

Figure E.13 Plug the S-Video
cable into your camera.



Capture Options
QuickTime provides many options, such as
compression schemes, when capturing video and
audio. These options are accessible from the
Capture Video window in Looking Glass. The video
and audio options buttons are just below the video
display (Figure E.14).

At the time of this writing, no USB capture device
drivers have been written for OS X. 

Video

The capture Video dialog box contains all the
options for altering video before digitizing. The first
pull down menu (Figure E.15) lists four options:
Compression, Image, Source, USB
Vision. The USB Vision options is only shown if
you have USB capture device connected to your
computer.

Compression

The Compress section allows you to specify a
compression codec for your video, a frame rate,
keyframes, data rate, and color depth. 

Compressors

When the camera or deck is connected via a
USB Capture Device, Looking Glass will
default to the USB Vision compressor. If a
DV camera or deck is connected via
FireWire, the default compressor will be
DV - NTSC. The other compressors are:
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Figure E.14 The Video and Audio option buttons
are just below the video display.

Figure E.15 The three main choices in the video
options window are Compression, Image, Source
and USB Vision if you have a USB capture
device connected.

• Animation
• Apple BMP
• DV-NTSC
• DV-PAL
• Graphics
• H.261
• H.263
• Intel Indeo© Video

R3.2
• Intel Raw
• Microsoft RLE

• Microsoft Video 1
• Microsoft JPEG A
• Microsoft JPEG B
• On2 VP3 Video 3.2
• Photo - JPEG
• PNG
• Sorenson Video
• TGA
• TIFF
• Video
• USB Vision



Depth

The depth feature allows for selecting the
color depth of the image you are capturing.
The default is Color and cannot be altered.

Quality

The quality feature allows for selecting the
quality of the image you are importing.
Looking Glass automatically chooses the
optimum quality setting. The higher the
quality, the bigger the file.

Frames Per Second

You can bring your video in at any FPS rate
you choose. The default is 30 for both DV
and USB connections. It is recommended
you import your video at 30 FPS, and lower
it if necessary when outputting your
finished project.

Key Frame

The Key Frame feature allows you to set
key frames throughout the media clip for
smoother playback. This is not needed on
import, and is disabled.

Limit Data Rate

This feature allows a ceiling to be applied
to the data rate of a media clip. This is
disabled for digitizing by QuickTime.

Image

The Image section allows you to adjust the
color, brightness and other aspects of the video
you are importing. This is only functional if
importing using a USB Capture Device. The
options are:

Source

The Source section contains options for
choosing the format and digitizers the video
will be processed by during input.

Digitizer

The Digitizer option contains the codecs
available for video that Looking Glass is
importing. If video is being imported via
FireWire, the choices are DV Video and
USB Vision. DV Video is the default and
the optimum choice.

Input

Input is dependent on the particular drivers
that are loaded when you plug in your
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camera. QuickTime supports dozens of
FireWire capable digital devices and
automatically loads the correct driver when
the device is connected. Looking Glass
automatically sets this selection for you.

Format

The format option specifies the regional
format of your video. NTSC is the default,
and is the standard for a video signal in the
United States. PAL is the European
standard, and SECAM is used by France,
the Middle East and most of Eastern
Europe. 

Do not select a regional standard
that is not your own. If you import
your video using a standard that is not used
by the media devices sold in your country,
you could possibly lose all chances of
playing your finished product on a standard
television or camera for your region. The
default format is NTSC.

Filter

The filter option is only available when
using a USB Capture Device. The choices
are ‘TV/Laserdisc’ or ‘VCR.’ The
‘TV/Laserdisc’ setting is superior and is the
recommended choice.

USB Vision

USBVision is only available when connecting
your camera to your computer via a USB
capture device.

USB Bandwidth

This option lets you adjust the amount of
information that your USB capture device
can send to your computer at one time.
Looking Glass recommends you keep the
setting at 100 (the default).

X off-set

Adjusts the position of the video over the X
coordinate. Looking Glass sets a default
value for you. Hitting the ‘Default’ button
restores the Looking Glass’ default if you
have moved it.



Y off-set

Adjusts the position of the video over the Y
coordinate. Looking Glass sets a default
value for you. Hitting the ‘Default’ button
restores the Looking Glass’ default if you
have moved it.

Still Image

Clicking this button will take the current
video frame being displayed and record it
as a still image.

Audio

When you click the audio tab you’ll be presented
with all the options Looking Glass provides to alter
and tweak your audio while digitizing. The first
pull-down menu lists three options: Compression,
Sample, and Source (Figure E.15).

The right side of the window presents you with an
option to turn on or off your external speakers
during digitizing, a Volume and Gain control, as
well as a VU meter. This meter fluctuates as you
play audio from your deck or camera through your
computer. If the meter goes into the red, then your
volume is to hot and it will sound distorted. If the
VU meter hardly moves, then your volume is to low
and will be barely audible. Adjust the Volume and
Gain controls as necessary. It is recommended
that the Volume remain at the default
setting of 100, and that only the Gain
control be adjusted.
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Figure E.15 The Sound options window has three
main choices: Compression, Sample, and Source.



Compression

The compress section allows you to specify a
compression codec for your audio. Looking
Glass currently supports 29 audio compressors.

Some of these compressors have options that
you adjust to fine tune their effects. If a
compressor does have options available the then
‘Options’ button will become clickable when
that compressor is chosen. The compressors
available are:

Sample

The sample section allows you to specify
the sample rate your audio will be captured
at. Choose between the kHz, sample bit
rate. The higher the quality you choose, the
bigger your audio files will be.

Source

Source has two options: ‘Device’ and
‘Input.’ The Source section allows you to
choose the source for the audio input.

Device

When your camera or deck is plugged in
via a FireWire cable then you will be
presented with three options in the ‘Device’
drop-down menu: Built-In, DV Audio, and
Internal CD.  
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Input

The choices in the Input drop down menu
will be based on what you have chosen as
your Device in the previous menu.

•Built-In: This option for Device allows
you to select from the audio 
sources built into your computer. The
selections include External 
Mic, Sound In, Internal Modem.

• DV Audio: Selecting DV Audio will pull
the sound directly from the 
device you have hooked up to your
computer via FireWire. You 
can then choose to record the sound in First
2 Channels (stereo), 
Second 2 Channels, or Mix 4 Channels.

• Internal CD: This option will give you
only one input choice: your CD-ROM
drive. If you place an audio CD inside your
CD-ROM drive you can record the sound
from CD as you digitize.

• MACE 3:1

• MACE 6:1

• Qdesign Music 2

• Qualcomm PureVoice™

• MetaSound AC24v1

• MetaVoice RT24v2

• MetaSound AC8v1

• MetaSound AC10v1

• MetaSound AC16v1

• MetaSound AC24v2

• MetaSound AC32V2.0

• MetaSound AC40V2.0

• MetaSound AC48V2.0

• MetaSound ACS16V2.0

• MetaSound ACS20V2.0

• MetaSound ACS32V2.0

• MetaSound ACS48V2.0

• MetaSound ACS64V2.0

• MetaSound ACS80V2.0

• MetaSound ACS96V2.0

• MetaSound AC06V2.0

• MetaSound ACS12V2.0

• ALaw 2:1

• 32-bit Floating Point

• 64-bit Floating Point

• IMA 4:1

• 24-bit Integer

• 32-bit Integer

• uLaw2:1



Supported File
Types

This appendix will list all the file types,
compression codecs, and export files that are
compatible with Looking Glass.

Audio Files Supported
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• Audio Interchange Format (aiff, aif, aifc)
• Global System for Mobile Audio (gsm, gsd)
• MP3 playlist files (m3u)
• Qualcomm PureVoice™ (qcp)
• uLaw (au, snd, ulw)
• MPEG Audio (mpeg, mpg, mp3)
• MPEG-1 Audio (mpeg, mpg, m1s, m1a, mp2, mpm, mpa)
• MPEG-2 Audio (mpeg, mpg, m1s, m1a, mp2, mpm, mpa)
• Musical Instrument Digital Interface (midi, mid, rmi, smf, kar)
• QuickTime Audio (mov, qt)
• Sound Designer 2 (sd2)
• Windows Wave (wav)
• SoundFont 2 (sd2)



Video Files Supported

Graphic Files Supported

Video Export Files Supported
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• AutoDesk Animator (flc, fli)
• Digital Video Stream (dv, dif)
• Shockwave Flash 3/4 (swf)
• MPEG-1 System (mpeg, mpg, dat, m1s, mpgx, mpm, rtf)
• MPEG-2 System (mpeg, mpg, m2s)
• MPEG-1 Video (mpeg, mpg, mpv, m1v, m75, m15)
• MPEG-2 Video (mpeg, mpg, m2v)
• QuickDraw Picture Sequence (pics)
• QuickTime Video (mov, qt)
• Video For Windows (avi, vfw)
• Animated Graphics Interchange Format (gif)

• Graphics Interchange Format (gif)
• JPEG File (jpg, jpeg, jpe)
• MacPaint (pntg, pnt, mac)
• Photshop (psd)
• Portable Network Graphics (png)
• QuickTime Image Format (qti)
• Silicon Graphics Image (sgi, rgb)
• Targa (tga, targa)
• Tagged Image File Format (tiff, tif)
• Windows Bitmap (bmp)

• Animation

• BMP

• Cinepak

• Component Video

• DV – NTSC

• DV – PAL

• Graphics

• H.261

• H.263

• Intel Indeo® Video 5.0

• Microsoft JPEG A

• Microsoft JPEG B

• None

• Photo – JPEG

• Planar RGB

• PNG

• Sorenson Video

• Sorenson Video 3

• TGA

• TIFF

• Video



Audio Export Files Supported
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• 24-bit Integer

• 32-bit Floating Point

• 32-bit Integer

• 64-bit Floating Point

• ALaw 2:1

• IMA 4:1

• MACE 3:1

• MACE 6:1

• MetaSound AC06 V2.0

• MetaSound AC10v1

• MetaSound AC10v2

• MetaSound AC16v1

• MetaSound AC16v2

• MetaSound AC24v1

• MetaSound AC24v2

• MetaSound AC32 V2.0

• MetaSound AC40 V2.0

• MetaSound AC48 V2.0 

• MetaSound AC8v1

• MetaSound AC8v2

• MetaSound ACS12 V2.0

• MetaSound ACS16 V2.0

• MetaSound ACS20 V2.0

• MetaSound ACS32 V2.0

• MetaSound ACS48 V2.0

• MetaSound ACS64 V2.0

• MetaSound ACS80 V2.0

• MetaSound ACS96 V2.0

• MetaVoice RT24v2

• QDesign Music 2

• Qualcomm PureVoice

• uLaw 2:1
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